


 
 
 

Татьяна Юрьевна Соколова
AutoCAD 2009. Учебный курс

 
 

Текст предоставлен издательством
http://www.litres.ru/pages/biblio_book/?art=183743

AutoCAD 2009. Учебный курс: Питер; Санкт-Петербург; 2008
ISBN 978-5-388-00279-2

 

Аннотация
Эта книга – практическое и справочное руководство, основа

для самостоятельного изучения и освоения новой англоязычной
версии самой популярной и мощной универсальной среды
проектирования AutoCAD 2009, разработанной компанией
Autodesk.

В издании приведены общие сведения об AutoCAD, подробно
описан интерфейс системы, рассказано о настройке рабочей
среды, формировании и редактировании объектов, командах
оформления чертежей, о свойствах объектов и работе со
слоями, уделено внимание вычислительным функциям системы.
Подробно описаны принципы трехмерного моделирования,
включая получение реалистических изображений, а также
твердых копий чертежей.

Изложение сопровождается многочисленными рисунками,
примерами, диалоговыми окнами, что облегчает не только
изучение, но и дальнейшую работу в среде AutoCAD. Таким



 
 
 

образом, книга может быть использована как учебное пособие и
как справочник.

Допущено Учебно-методическим объединением вузов
Российской Федерации по образованию в области дизайна,
монументального и декоративного искусства в качестве учебного
пособия для студентов высших учебных заведений, обучающихся
по специальности 070601 «Дизайн».

Компакт-диск прилагается только к печатному
изданию книги.
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Татьяна Юрьевна Соколова
AutoCAD 2009.
Учебный курс

 
Введение

 
Постоянно растущий уровень компьютерных технологий,

динамичное развитие программных и аппаратных средств
влекут за собой бурный переход от традиционных методов
ведения проектно-конструкторских работ к использованию
новых автоматизированных систем разработки и выполне-
ния конструкторской документации.

На сегодняшний день производство продукции мирового
класса возможно только на соответствующем оборудовании
и с использованием современных средств автоматизации.
Ни одно предприятие, ведущее разработки сложных тех-
нических объектов, теперь не обходится без использования
компьютеров и мощного программного обеспечения, позво-
ляющего гармонично сочетать форму и содержание проек-
та, оптимизировать процесс разработки и выполнения кон-
структорской документации при многократном использова-
нии имеющихся данных.

Базовые графические системы обогащают, но не услож-



 
 
 

няют возможности творческого поиска конструкторов, по-
скольку обладают высокотехнологичными и удобными, про-
стыми в обращении инструментами, при помощи которых в
одном проекте реализуются замыслы целой команды проек-
тировщиков и требования заказчиков. На базе универсаль-
ных графических систем разрабатываются автоматизирован-
ные рабочие места конструкторов, технологов, архитекто-
ров, схемотехников и многих других разработчиков.

Новейшие компьютерные технологии предоставляют со-
временные аппаратные, программные и информационные
средства, реализующие автоматизацию инженерно-графиче-
ских работ. При этом предполагается обеспечение ввода, вы-
вода, создания, хранения и обработки моделей геометриче-
ских объектов и их изображений с помощью компьютера, а
также наличие средств моделирования геометрических объ-
ектов, их обработки и др.

В последнее время все больше утверждается оригиналь-
ный подход к автоматизации конструкторской деятельно-
сти, в основе которого – создание трехмерных геометриче-
ских представлений графических моделей изделий. Совре-
менный уровень развития компьютерных технологий позво-
ляет создавать пространственные модели объектов с практи-
чески неограниченными возможностями, обеспечивая боль-
шую достоверность решения геометрических и других задач
для пространственной модели, что позволяет перейти на ка-
чественно новый уровень разработки.



 
 
 

В настоящее время существует множество графических
редакторов и программ геометрического моделирования.
Компания Autodesk – один из ведущих производителей си-
стем автоматизированного проектирования и программного
обеспечения для конструкторов, дизайнеров, архитекторов.
Это крупнейший в мире поставщик программного обеспече-
ния и услуг для промышленного и гражданского строитель-
ства, машиностроения, геоинформатики, цифровых средств
передачи информации и беспроводной связи, обслуживаю-
щий 7 000 000 пользователей.

Система AutoCAD, разработанная этой компанией, яв-
ляется лидирующей в мире платформой программного
обеспечения систем автоматизированного проектирования
(САПР), предназначенной для профессионалов, которым
требуется воплощать свои творческие замыслы в реальные
динамические проекты.

AutoCAD – программа с богатой и во многом уникальной
историей. Впервые она увидела свет в 1982 году под име-
нем MicroCAD. Первая версия AutoCAD ознаменовала на-
чало настоящей революции в автоматизированном проекти-
ровании. Сегодня AutoCAD переводится на 18 языков, ее
используют в своей работе миллионы проектировщиков во
всем мире на процессорах в тысячи раз мощнее тех, которые
были установлены на первых персональных компьютерах.

AutoCAD является постоянно развивающейся базовой
средой проектирования, каждая новая версия которой на-



 
 
 

следует все лучшее от предыдущих и направлена на реше-
ние следующих основных задач: повышение производитель-
ности и эффективности работы пользователей; обеспечение
многократного использования имеющихся наработок; бес-
препятственное сотрудничество пользователей при проекти-
ровании; адаптация AutoCAD к индивидуальным потребно-
стям разработчиков объектно-ориентированных задач.

Залог успеха Autodesk – мировое признание AutoCAD
в качестве стандарта де-факто для разработки продуктов и
комплектующих, а также для документации.

Используя свою стратегию, направленную на помощь за-
казчикам в создании, организации и распространении циф-
ровых конструкторских данных и в решении серьезных биз-
нес-проблем, Autodesk предлагает наиболее полный ком-
плект интегрированных программных инструментов дву-
мерного и трехмерного конструирования, что позволяет со-
здавать более качественные продукты, ускорять вывод изде-
лий на рынок и добиваться максимальной наглядности про-
ектов и максимально эффективного сотрудничества.

Благодаря выпуску AutoCAD 2009 компания Autodesk
предлагает архитекторам, дизайнерам, инженерам и проек-
тировщикам новый инструмент для еще более полного во-
площения их идей в реальность.



 
 
 

 
От издательства

 
Ваши замечания, предложения и вопросы отправляйте по

адресу электронной почты dgurski@minsk.piter.com  (изда-
тельство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете по-

дробную информацию о наших книгах.

mailto:dgurski@minsk.piter.com
http://www.piter.com/


 
 
 

 
Глава 1

AutoCAD 2009. Общие сведения
 

Требования к системе
Запуск системы AutoCAD
Начало работы
Подробнее о шаблоне
Вызов справочной системы
Открытие рисунков
Создание рисунков
Определение границ рисунка
Определение параметров сетки
Определение шага привязки
Совмещение шаговой привязки с полярным отсле-

живанием
Установка изометрического стиля сетки и шаговой

привязки
Определение формата единиц
Сохранение рисунков
Получение твердой копии рисунка
Выход из AutoCAD



 
 
 

 
Требования к системе

 
AutoCAD может работать как в автономном режиме, так и

в локальной сети. Для эффективной работы AutoCAD 2009
под управлением операционной системы Windows необходи-
мы следующие программные и аппаратные средства:

• процессор Intel® Pentium® IV;
• операционные системы: Microsoft® Windows® XP

Professional или Home Edition (пакет обновлений SP1 или
SP2), Windows XP Tablet PC Edition (SP2) или Windows 2000
(SP3 или SP4). Рекомендуется устанавливать и эксплуатиро-
вать AutoCAD либо на операционной системе, локализован-
ной на одном языке с программой, либо на англоязычной
версии одной из перечисленных систем;

• Microsoft® Internet Explorer 6.0 (пакет обновлений SP1
или более поздний);

• 512 Мбайт оперативной памяти;
• монитор VGA с разрешением не менее 1024 × 768 и под-

держкой режима true color;
• 750 Мбайт свободного места на жестком диске для уста-

новки;
• привод компакт-дисков: любой (только для установки

программы).
Требования к системе при использовании AutoCAD 2009

для концептуального проектирования:



 
 
 

• процессор Intel® с тактовой частотой 3 ГГц и выше;
• Windows XP Professional (пакет обновлений SP2);
• не менее 2 Гбайт оперативной памяти;
• 2 Гбайт свободного места на жестком диске, не считая

места, необходимого для установки программы;
• монитор с минимальным разрешением 1280 × 1024 и

поддержкой режима true color;
• графический адаптер класса рабочих станций, снабжен-

ный не менее 128 Мбайт памяти и поддерживающий техно-
логию OpenGL.



 
 
 

 
Запуск системы AutoCAD

 
Запуск AutoCAD осуществляется следующими способа-

ми:
• на Панели задач выберите из меню Start → Programs →

Autodesk → AutoCAD 2009;
• на Рабочем столе Windows дважды щелкните на пикто-

грамме AutoCAD 2009.
При запуске AutoCAD предлагает создать новый неиме-

нованный рисунок. Можно либо начать создавать в нем объ-
екты, либо загрузить с диска один из уже имеющихся фай-
лов.

При открытии ранее подготовленного имеющегося рисун-
ка всем системным переменным присваиваются значения,
которые они имели в ходе последнего сеанса работы с ним.
Это происходит благодаря тому, что переменные сохраняют-
ся в файле вместе с рисунком.

Если же вы начинаете работу с нуля, следует предвари-
тельно задать ряд установок. Обычно это делается автома-
тически с помощью Мастера подготовки Wizard Description.
AutoCAD позволяет менять установки и в ходе сеанса, если
возникает такая необходимость.



 
 
 

 
Начало работы

 
После запуска AutoCAD выводится диалоговое окно на-

чала работы Startup (рис. 1.1).

Рис. 1.1. Диалоговое окно начала работы

В диалоговом окне Startup пользователю предлагается че-
тыре кнопки, в зависимости от выбора которых меняется со-
держимое диалогового окна:



 
 
 

Open a Drawing – для открытия ранее созданного чертежа.
Позволяет выбрать из списка один из рисунков, открывав-
шихся последними, и загрузить его в AutoCAD. Чтобы за-
грузить файл, отсутствующий в списке, следует нажать кноп-
ку обзора Browse…;

Start from Scratch – для создания чертежа, где устанавли-
ваются только единицы измерения в области Default Settings:
британские (футы и дюймы) или метрические (миллимет-
ры):

– Imperial (feet and inches) – создание нового рисунка,
использующего британскую систему единиц измерения, по
шаблону acad.dwt. При этом область рисования, называемая
еще лимитами рисунка, устанавливается равной 12 × 9 дюй-
мов;

– Metric – создание нового рисунка, использующе-
го метрическую систему единиц измерения, по шаблону
acadiso.dwt. При этом область рисования устанавливается
равной 429 × 297 мм;



 
 
 

Use a Template – для создания чертежа по шаблону – доку-
менту, установки которого используются как основа для но-
вого рисунка. В области Select a Template: выбирается шаб-
лон, содержащий необходимые установки черчения. В спис-
ке перечисляются имена файлов шаблонов с расширением
DWT, которые найдены по стандартному пути, заданному в
диалоговом окне настроек Options. В шаблонах определяют-
ся различные параметры рисунка, в том числе наборы спе-
циально созданных слоев, типов линий и видов;

Use a Wizard – вызов Мастера для установки параметров
нового чертежа. В области Select a Wizard: предлагается два
режима автоматической настройки рабочей среды AutoCAD
– детальная подготовка Advanced Setup и быстрая подготов-
ка Quick Setup:

– диалоговое окно детальной подготовки Advanced Setup
позволяет выполнить полную установку параметров рабочей
среды AutoCAD: назначить единицы измерения длины Units
и угла Angle, задать начало отсчета угла Angle Measure и на-
правление его измерения Angle Direction, определить грани-



 
 
 

цы области рисунка Area;
– диалоговое окно быстрой подготовки Quick Setup поз-

воляет выполнить быструю установку параметров рабочей
среды AutoCAD: выбрать единицы измерения длины Units и
определить границы области черчения Area.

Диалоговое окно начала работы Startup вызывается при
каждой загрузке сеанса AutoCAD только один раз. В даль-
нейшем для создания рисунков в уже запущенном сеансе
AutoCAD открывается диалоговое окно создания нового ри-
сунка Create New Drawing.



 
 
 

 
Подробнее о шаблоне

 
Установленный набор параметров сеанса можно сделать

доступным и для рисунков, создаваемых впоследствии. Для
этого следует сохранить документ как шаблон. Шаблон
обычно представляет собой рисунок, не содержащий ника-
ких графических объектов и используемый только для хра-
нения стандартных значений системных переменных.

Шаблоны (файлы с расширением DWT) – весьма удоб-
ное средство создания набора рисунков с однотипными на-
стройками. Можно использовать как шаблоны, поставляе-
мые с AutoCAD, так и созданные пользователем. Любой
имеющийся рисунок можно сохранить в качестве шаблона.
В этом случае значения всех параметров настройки сохра-
няемого документа будут наследоваться всеми создаваемы-
ми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше
всего подготовить набор стандартных шаблонов, где пред-
ставлены чаще всего используемые установки и базовые эле-
менты:

• тип и точность представления единиц;
• лимиты рисунка;
• настройки режимов шага SNAP, сетки GRID и ортого-

нального режима ORTHO;
• организация слоев;



 
 
 

• основные надписи, рамки и логотипы;
• размерные и текстовые стили;
• типы и веса (толщины) линий.
Никакие изменения, вносимые в рисунок, созданный на

основе шаблона, на сам шаблон не распространяются.



 
 
 

 
Вызов справочной системы

 

В любой момент работы с AutoCAD вы можете получить
доступ к электронной документации по программе. Для это-
го необходимо выбрать в падающем меню пункт Help. Аль-
тернативный вариант – нажать клавишу F1 на функциональ-
ной клавиатуре, ввести символ ? в  командной строке или
щелкнуть на пиктограмме со значком вопроса на стандарт-
ной панели инструментов.



 
 
 

 
Открытие рисунков

 
Программа AutoCAD по умолчанию записывает внутрен-

нее представление рисунка в файл с расширением DWG.
Кроме рисунка файл содержит ряд параметров, определяю-
щих значения переключателей режимов шага SNAP, сетки
GRID, ортогонального режима ORTHO; принятые единицы
измерения и точность представления; границы рисунка; ор-
ганизацию слоев; форматы и логотипы; размерные и тексто-
вые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирова-
ния Multiple Design Environment (MDE), которая допускает
одновременное открытие нескольких чертежей. В одном се-
ансе работы можно открывать неограниченное количество
рисунков, не жертвуя при этом производительностью. Среда
MDE позволяет перетаскивать объекты, копировать их свой-
ства, такие как цвет, слой, тип линии, из одного рисунка в
другой. Она обеспечивает параллельную работу с нескольки-
ми рисунками, не прерывая выполнения текущей команды и
не нарушая последовательности действий. Это существенно
упрощает выполнение многих операций и повышает эффек-
тивность работы.



 
 
 

Открыть существующий рисунок можно с помощью ко-
манды OPEN, которая вызывается из падающего меню File
→ Open… или щелчком на пиктограмме Open…CTRL+O на
стандартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD
появляется диалоговое окно выбора файла Select File (рис.
1.2). Здесь можно выбрать имя файла из списка или ввести
это название в поле File name:.

Рис. 1.2. Диалоговое окно выбора файла

При выделении в списке одного из файлов в области
Preview появляется соответствующий образец рисунка. На-



 
 
 

жатие кнопки Views выводит список, изменяя параметры ко-
торого пользователь может выбрать форму представления
файлов, предлагаемых для открытия: список, таблицу, об-
разцы.

Режим открытия файлов – Open (Открыть), Open Read-
Only (Открыть для чтения), Partial Open (Открыть частич-
но), Partial Open Read-Only (Открыть для чтения частич-
но) – устанавливается в списке при нажатии стрелки спра-
ва от кнопки Open. Частичное открытие позволяет загру-
жать только те объекты рисунка, которые принадлежат опре-
деленным слоям или видовым экранам. Это оказывается по-
лезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следу-
ет выбрать необходимые файлы в диалоговом окне Select
File, используя клавишу Shift или Ctrl.

Кроме того, рисунки можно открывать путем перетаски-
вания из Проводника Windows. Для этого один или несколь-
ко выделенных в дереве Проводника файлов следует перета-
щить с помощью мыши в любую часть окна AutoCAD, за ис-
ключением области рисунка, например на командную стро-
ку или в ту часть панелей инструментов, которая не занята
кнопками. Если же перетащить один файл в область рисова-
ния уже открытого рисунка, то произойдет вставка содержи-
мого перетаскиваемого документа в текущий рисунок в ка-
честве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени



 
 
 

соответствующего файла в Проводнике Windows, что приве-
дет к автоматическому запуску AutoCAD. Если же в системе
уже ведется сеанс работы в AutoCAD, то рисунок откроется
в нем.

В AutoCAD имеется специальное средство просмотра
небольших фрагментов рисунков, открытия файлов рисун-
ков и их поиска. Его можно использовать для поиска файлов
в структуре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска фай-
лов Find, показанного на рис. 1.3, необходимо в диалоговом
окне Select File последовательно щелкнуть на кнопках Tools
→ Find….



 
 
 

Рис. 1.3. Диалоговое окно просмотра и поиска файлов

На вкладке Name & Location диалогового окна Find ука-
зываются имя, расширение и область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам
их создания, пользуясь вкладкой Date Modified диалогового
окна Find (рис. 1.4). Здесь организуется поиск файлов, со-
зданных или измененных в период между двумя указанны-
ми датами либо за определенное количество последних дней
или месяцев. Имена найденных документов отображаются в
нижней части диалогового окна.



 
 
 

Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей
версии, открываются как любой документ версии 2009 и ав-
томатически преобразуются в новый формат.



 
 
 

 
Создание рисунков

 
При создании рисунка могут использоваться различные

стандарты. Иногда они диктуются государственными и от-
раслевыми стандартами или нормами предприятия, иногда
– требованиями заказчика. Ключевой момент как для непо-
средственных исполнителей, так и для руководителей групп,
контролирующих ход выполнения проекта, – грамотная под-
готовка начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект.
Он может включать в себя множество разделов: планы эта-
жей, схемы сетей водоснабжения, канализации, отопления,
вентиляции и т. п. Обычно каждый раздел проекта разраба-
тывается в отдельном подразделении, поэтому здесь остро
встает проблема унификации. Наиболее грамотное ее реше-
ние – обеспечение всех исполнителей файлами шаблонов,
настроенными на используемую систему единиц и содержа-
щими стандартные рамку, основную надпись, слои и типы
линий.

Не менее важно, какие стили используются для текстовых
надписей, штрихования и нанесения размеров. Их также сле-
дует задавать заранее: это дает гарантию, что каждый проек-
тировщик будет действовать без отклонения от оговоренных
стандартов.

Следует ответственно подходить к выбору рабочего мас-



 
 
 

штаба. Только четкое представление о том, как соотносятся
единицы рисунка на экране и единицы чертежа, выводимого
на плоттер, позволяет правильно выбрать высоту текста для
пояснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на по-
следних стадиях проектирования, грамотное планирование
на предварительных этапах позволяет избежать многих оши-
бок и избавить персонал от излишних операций редактиро-
вания. При создании проекта работа, как правило, ведется в
пространстве модели (здесь объекты представляются в нату-
ральную величину), а для компоновки чертежа выполняется
переход в пространство листа, где ко всем графическим объ-
ектам, текстам, типам линий и размерам применяется необ-
ходимый масштабный коэффициент.

Все начальные установки рисунка могут быть сохранены
в шаблоне для последующего использования в других доку-
ментах. В качестве шаблона могут применяться как рисунки,
поставляемые с AutoCAD, так и любые другие, в том чис-
ле созданные пользователем. Новый рисунок наследует всю
информацию из используемого шаблона. Имеется также воз-
можность запускать AutoCAD без шаблона.

Создать новый рисунок позволяет команда NEW, вызы-
ваемая из падающего меню File → New… или щелчком на



 
 
 

пиктограмме QNew на стандартной панели инструментов.
После запуска команды необходимые настройки парамет-

ров рабочей среды AutoCAD производятся в диалоговом ок-
не создания нового рисунка Create New Drawing – рис. 1.5.

Рис. 1.5. Диалоговое окно создания нового рисунка

При создании рисунка по простейшему шаблону исполь-
зуется пиктограмма Start from Scratch. В данном режиме
устанавливается британская или метрическая система еди-
ниц. Значения многих системных переменных, принятые по
умолчанию, зависят от того, какая из двух систем выбрана.



 
 
 

Эти переменные управляют текстом, размерами, сеткой, ре-
жимами привязки, а также устанавливают действующие по
умолчанию тип линий и файл образцов штриховки:

• Imperial (feet and inches) – создается рисунок, использу-
ющий британскую систему единиц измерения (футы и дюй-
мы), по шаблону acad.dwt. При этом область рисования, ина-
че называемая лимитами рисунка, устанавливается равной
12 × 9 дюймов;

• Metric – создается рисунок, где используется метриче-
ская система единиц измерения, по шаблону acadiso.dwt.
При этом устанавливается область рисования 429 × 297 мм.

Чтобы создать рисунок с использованием шаблона, необ-
ходимо в диалоговом окне Create New Drawing щелкнуть на
пиктограмме Use a Template и в списке Select a Template:
указать нужный шаблон (рис. 1.6).



 
 
 

Рис. 1.6. Выбор шаблона рисунка

В AutoCAD имеется так называемый Мастер подготовки
Wizard – служебное средство для создания нового рисунка.
С помощью Мастера подготовки можно, взяв за основу теку-
щий шаблон, модифицировать некоторые базовые установ-
ки. Например, пользователь может автоматически настраи-
вать масштабные коэффициенты для текста в зависимости
от общих размеров рисунка. Если рисунки крупные, выбира-
ется большая высота символов, если мелкие – меньшая; та-
ким образом обеспечивается разборчивость текстовых над-



 
 
 

писей, когда рисунок отображается на экране целиком.
Для вызова Мастера подготовки необходимо в диалого-

вом окне Create New Drawing щелкнуть на пиктограмме Use
a Wizard – откроется окно, показанное на рис. 1.7.

Рис. 1.7. Создание нового рисунка с помощью Мастера
подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.8) позво-
ляет задать для нового рисунка единицы измерения Units
и область рисования Area. Поддерживаются следующие ти-
пы единиц для рисования и вычерчивания: десятичные



 
 
 

– Decimal, инженерные – Engineering, архитектурные –
Architectural, дробные – Fractional, научные – Scientific.

Рис. 1.8. Диалоговое окно Мастера быстрой подготовки

Указывая ширину Width и длину Length области рисова-
ния, пользователь тем самым задает граничные пределы ри-
сунка, так называемые лимиты. Именно лимитами опреде-
ляется размер чертежа, впоследствии выводимого на плот-
тер. После того как все параметры заданы, Мастер быстрой
подготовки запускает сеанс рисования в пространстве моде-
ли.

Мастер детальной подготовки Advanced Setup (рис. 1.9)
позволяет задать для нового рисунка тип линейных единиц



 
 
 

измерения Units и способ измерения углов Angle, указать на-
чало отсчета угла Angle Measure и направление измерения
угла Angle Direction, определить границы области рисунка
Area. В отличие от Мастера быстрой подготовки, который
настраивает только пространство модели, Мастер детальной
подготовки воздействует как на пространство модели, так и
на пространство листа.

Рис. 1.9. Диалоговое окно Мастера детальной подготовки

Любая из установок, произведенных в начале рисования,
в дальнейшем может быть изменена.



 
 
 

 
Определение границ рисунка

 
Команда LIMITS позволяет установить границы теку-

щего рисунка в пространстве модели и в пространстве ли-
ста. Она вызывается из падающего меню Format → Drawing
Limits. В AutoCAD границы рисунка выполняют две функ-
ции: определяют диапазон изменения координат точек и
контролируют фрагмент рисунка, покрытый видимой коор-
динатной сеткой.

Границы рисунка – это пара двумерных точек в мировой
системе координат: координаты левого нижнего и правого
верхнего углов, определяющие прямоугольную область. По
оси Z границы не устанавливаются.

Запросы команды LIMITS:
Reset Model space limits: – переустановка лимитов

пространства модели
Specify lower left corner or [ON/OFF] <current>: –

левый нижний угол
Specify upper right corner <current>: – правый

верхний угол

где:
• ON – включается контроль соблюдения границ. При

этом AutoCAD отвергает все попытки ввести точки с коор-
динатами, выходящими за границы рисунка;

• OFF – отключается контроль соблюдения границ рисун-



 
 
 

ка;
• <current> – текущее значение.
Если текущее значение границ рисунка вас устраивает,

достаточно нажать клавишу Enter.
Лимиты должны полностью охватывать полномасштаб-

ную модель. Например, если ее размеры 100 × 200 мм, зна-
чения лимитов должны слегка превышать эти цифры.

В пространстве листа лимиты обычно задают равными
формату листа бумаги. Следовательно, сетка (если она вклю-
чена) покрывает при этом весь скомпонованный чертеж,
включая графические объекты, размерные элементы, основ-
ную надпись и т. п. Например, если формат листа равен 210
× 297 мм, следует установить десятичный формат единиц и
определить лимиты указанием точек 0,0 для левого нижнего
угла прямоугольника и 210,297 – для правого верхнего угла.

Если в пространстве листа отображаются поля листа или
подложен заданный формат, нельзя задать границы рисун-
ка с помощью команды LIMITS. В этом случае лимиты вы-
числяются и устанавливаются в зависимости от размеров вы-
бранного листа. Включение и отключение отображения по-
лей и разметки листа производятся на вкладке Display диа-
логового окна Options.

В пространстве модели лимиты могут быть заданы при со-
здании нового рисунка с помощью Мастера быстрой подго-
товки или Мастера детальной подготовки.



 
 
 

 
Определение параметров сетки

 
Сеткой называется упорядоченная последовательность

точек, покрывающих область рисунка в пределах лимитов.
Работа в режиме GRID подобна наложению на рисунок ли-
ста бумаги в клетку. Использование сетки помогает вырав-
нивать объекты и оценивать расстояние между ними. Сетку
можно включать и отключать в ходе выполнения других ко-
манд. На печать она не выводится.

Включение сетки и определение ее частоты осуществля-
ется на вкладке Snap and Grid диалогового окна режимов ри-
сования Drafting Settings (рис. 1.10), которое загружается из
падающего меню Tools → Drafting Settings… или при выбо-
ре пункта настройки Settings… контекстного меню, вызыва-
емого щелчком правой кнопки мыши на кнопке Grid Display
в строке состояния.



 
 
 

Рис. 1.10. Диалоговое окно определения параметров сет-
ки и шага привязки

Сетка включается при установке флажка Grid On (F7). В
области Grid spacing устанавливается частота горизонталь-
ных и вертикальных делений сетки, то есть шаг сетки по
осям X и Y. Это осуществляется в текстовых полях Grid X
spacing: и Grid Y spacing: соответственно. В поле Major line



 
 
 

every: устанавливается шаг основной линии.
• В области Grid behavior определяется режим сетки:

Adaptive grid – настройка сетки, Allow subdivision below grid
spacing – разрешение дробления мельче шага сетки, Display
grid beyond Limits – показать сетку за лимитами, Follow
Dynamic UCS – следовать динамической ПСК.

При работе с рисунком включать и отключать сетку сле-
дует щелчком на кнопке Grid Display в строке состояния или
нажатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с
новым коэффициентом экранного увеличения может потре-
боваться изменение частоты сетки.



 
 
 

 
Определение шага привязки

 
В режиме шаговой привязки SNAP курсор может нахо-

диться только в определенных точках согласно установлен-
ному значению шага и при этом движется не плавно, а скач-
кообразно между узлами воображаемой сетки, как бы «при-
липая» к ее узлам. Активность режима шаговой привяз-
ки SNAP можно определить визуально, по скачкообразному
движению курсора на экране. Шаговая привязка обычно ис-
пользуется для точного указания точек с помощью мыши.
Интервал привязки задается отдельно по осям X и Y. Вклю-
чение и отключение режима шаговой привязки может про-
изводиться в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сет-
ки. Сетку часто делают достаточно редкой, используя ее ис-
ключительно для наглядности, а шаг привязки устанавлива-
ют меньшим. Допустимо и обратное: установка большего по
сравнению с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее пара-
метров осуществляются на вкладке Snap and Grid диалого-
вого окна режимов рисования Drafting Settings, которое за-
гружается из падающего меню Tools → Drafting Settings…
или при выборе пункта Settings… из контекстного меню, вы-
зываемого щелчком правой кнопки мыши на кнопке Snap
Mode в строке состояния (см. рис. 1.10).



 
 
 

Шаговая привязка включается при установке флажка
Snap On (F9). В области Snap spacing задается шаг привязки
по горизонтали и вертикали. Это осуществляется в тексто-
вых полях Snap X spacing: и Snap Y spacing: соответственно.

Параметром Equal X and Y spacing устанавливается рав-
ный шаг по осям X и Y. В области Polar spacing задается шаг
полярной привязки.

Тип привязки устанавливается в области Snap type. Grid
snap – шаговая привязка (Rectangular snap – ортогональная,
Isometric snap – изометрическая), PolarSnap – полярная при-
вязка.

При работе с рисунком включать и отключать шаговую
привязку следует щелчком на кнопке Snap Mode в строке со-
стояния или нажатием функциональной клавиши F9.



 
 
 

 
Совмещение шаговой привязки

с полярным отслеживанием
 

При использовании полярного отслеживания можно уста-
новить такой режим шаговой привязки, в котором узлы рас-
полагаются только вдоль линий полярного отслеживания че-
рез заданные интервалы.

Для настройки шаговой привязки на совместную работу с
полярным отслеживанием необходимо выбрать из падающе-
го меню Tools → Drafting Settings… и затем на вкладке Snap
and Grid диалогового окна Drafting Settings в области Snap
type отметить пункт полярной привязки PolarSnap – см. рис.
1.10. Затем в области Polar spacing в текстовом поле Polar
distance: задать величину шага привязки.



 
 
 

 
Установка изометрического

стиля сетки и шаговой привязки
 

Изометрический стиль сетки и шаговой привязки помо-
гает строить двумерные рисунки, представляющие трехмер-
ные объекты (например, куб). Аксонометрия (в том числе
и изометрия) – это не что иное, как средство изображения
трехмерных объектов на плоскости, то есть имитация объ-
ема, а не трехмерная модель. Поэтому изометрические ри-
сунки нельзя рассматривать в перспективной проекции или
под различными углами. Имитация трехмерности достигает-
ся здесь за счет расположения объектов по трем изометри-
ческим осям. При нулевом угле поворота шаговой привяз-
ки направления изометрических осей следующие: 30, 90 и
150°. Узлы сетки и шаговой привязки можно ориентировать
вдоль левой, правой или верхней изометрической плоскости
(рис. 1.11); переключение между плоскостями осуществля-
ется нажатием функциональной клавиши F5 (или сочетания
CTRL+E):

• левая: сетка и шаговая привязка ориентируются вдоль
осей, направленных под углами 90 и 150°;

• правая: сетка и шаговая привязка ориентируются вдоль
осей, направленных под углами 90 и 30°;

• верхняя: сетка и шаговая привязка ориентируются вдоль
осей, направленных под углами 30 и 150°.



 
 
 

Рис. 1.11. Оси изометрической сетки привязки

При выборе изометрического стиля шаговая привязка,
сетка и указатель мыши в виде перекрестья поворачивают-
ся соответственно выбранным изометрическим осям. При
определенных условиях в AutoCAD допускается указание
только тех точек, которые лежат в одной из изометриче-
ских плоскостей. Например, когда включен ортогональный
режим ORTHO, указываемые при рисовании точки распо-
лагаются в текущей изометрической плоскости. Таким обра-
зом, можно вначале нарисовать верхнюю плоскость модели,
затем, переключившись на левую плоскость, построить одну
из сторон модели, а после этого завершить построение, вы-
брав правую плоскость.



 
 
 

Для включения изометрии необходимо выбрать из пада-
ющего меню Tools → Drafting Settings… и далее на вкладке
Snap and Grid диалогового окна Drafting Settings в области
Snap type отметить пункт Isometric snap – см. рис. 1.10.



 
 
 

 
Определение формата единиц

 
Размеры каждого из создаваемых в AutoCAD объектов за-

даются в условных единицах измерения. Соответствие еди-
ниц AutoCAD и единиц существующих метрических систем
устанавливается перед рисованием. Так, в одном рисунке
единица может соответствовать одному миллиметру, в дру-
гом – одному дюйму и т. д. Заданные значения определя-
ют интерпретацию вводимых координат и углов, а также вид
отображаемых координат и размеров.

Тип и точность представления единиц назначают в диало-
говом окне определения форматов единиц Drawing Units, по-
казанном на рис. 1.12. Оно вызывается из падающего меню
Format → Units…. В области Length устанавливаются фор-
мат Type: и точность Precision: линейных единиц измерения,
в области Angle – формат Type: и точность Precision: угло-
вых единиц. Параметр Clockwise определяет отсчет по часо-
вой стрелке.



 
 
 

Рис. 1.12. Диалоговое окно определения форматов еди-
ниц



 
 
 

Для измерения расстояний предлагаются следующие фор-
маты единиц:

• Architectural – архитектурные;
• Decimal – десятичные;
• Engineering – инженерные;
• Fractional – дробные;
• Scientific – научные.
В техническом и архитектурном форматах значения чи-

сел записываются в футах и дюймах; при этом предполага-
ется, что условная единица составляет один дюйм.

Для измерения угловых величин предлагаются следую-
щие форматы единиц:

• Decimal Degrees – десятичные градусы;
• Deg/Min/Sec – градусы/минуты/секунды;
• Grads – грады;
• Radians – радианы;
• Surveyor's Units – топографические единицы.
Для указания нулевого угла необходимо щелкнуть на

кнопке Direction…. Появляется диалоговое окно выбора на-
правления Direction Control – рис. 1.13.



 
 
 

Рис. 1.13. Диалоговое окно выбора направления

Нулевым называется направление, относительно которого
AutoCAD измеряет углы. По умолчанию таковым считается
направление вправо от исходной точки.

Направление отсчета задается при помощи кнопок East –
восток, North – север, West – запад, South – юг или Other –
другое. При выборе последней открывается доступ к кноп-
ке Angle:, с помощью которой задается угол путем указания



 
 
 

двух точек в графической зоне экрана или в текстовом поле,
куда вводится числовое значение угла.



 
 
 

 
Сохранение рисунков

 

Команда сохранения рисунка QSAVE вызывается из па-
дающего меню File → Save или щелчком на пиктограмме
Save CTRL+S на стандартной панели инструментов. Коман-
да QSAVE используется в тех случаях, когда уже существу-
ющий рисунок сохраняется без изменения его имени. Если
рисунок новый и его имя не определено, то QSAVE действу-
ет так же, как команда SAVEAS.

Команды SAVE и SAVEAS предназначены для сохране-
ния рисунка под другим именем. Команда SAVE может вы-
зываться только из командной строки, а SAVEAS – из падаю-
щего меню File → Save As…. В обоих случаях имя докумен-
та задается в поле File name: диалогового окна Save Drawing
As – рис. 1.14.



 
 
 

Рис. 1.14. Диалоговое окно сохранения рисунка

Предыдущей копии рисунка на диске присваивается рас-
ширение BAK вместо DWG. Все предыдущие BAK-файлы
с данным именем удаляются. Обновленный рисунок запи-
сывается с расширением DWG. Если при указании имени
файла оказывается, что рисунок с таким названием уже су-
ществует, выдается предупреждение и предоставляется воз-
можность перезаписать файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в
раскрывающемся списке Files of type: диалогового окна Save
Drawing As необходимо выбрать пункт AutoCAD Drawing



 
 
 

Template (*.dwt).
Чтобы обеспечить автоматическое сохранение рисунка

через заданные интервалы времени, следует использовать
системную переменную SAVETIME или вкладку Open and
Save диалогового окна Options. Оно вызывается из падающе-
го меню Tools → Options…. В последнем случае необходи-
мо поставить флажок автосохранения Automatic save в обла-
сти File Safety Precautions и установить значение интервала
в минутах между автосохранениями в поле Minutes between
saves.



 
 
 

 
Получение твердой копии рисунка

 
Распечатка чертежа – последний этап при работе с рисун-

ком. Перед выводом рисунка на печать необходимо его ском-
поновать, то есть определить, какие виды должны быть вы-
черчены. Работа над рисунком ведется на разных этапах ли-
бо в пространстве модели, либо в пространстве листа. Про-
странство модели предназначено для создания модели –
изображения в реальном масштабе. Пространство листа
представляет собой аналог листа бумаги, на котором произ-
водится создание и размещение видов перед вычерчивани-
ем.

Как в пространстве модели, так и в пространстве листа
может быть один или несколько видовых экранов, на кото-
рых представлены различные виды модели. Компоновка чер-
тежа, по сути дела, представляет собой процесс создания и
размещения таких экранов. По завершении компоновки чер-
теж выводится на принтер или плоттер.

Перед выводом рисунка на плоттер можно предваритель-
но просмотреть, как он будет размещаться на листе бума-
ги. Для этого используется команда предварительного про-
смотра PREVIEW, вызываемая из падающего меню File →



 
 
 

Plot Preview или щелчком на пиктограмме Plot Preview на
стандартной панели инструментов. При этом автоматиче-
ски включается изменение масштаба изображения в режи-
ме реального времени для просмотра мелких деталей черте-
жа. Для изменения режима масштаба изображения, вывода
на плоттер, использования панорамирования или выхода из
предварительного просмотра используется контекстное ме-
ню (рис. 1.15), которое вызывается в ответ на щелчок правой
кнопкой мыши.

Рис. 1.15. Контекстное меню

Все установки вывода рисунка на плоттер осуществляют-
ся в диалоговом окне Plot – Model (рис. 1.16). Это окно за-
гружается командой PLOT, вызываемой из падающего меню
File → Plot… или щелчком на пиктограмме Plot… (CTRL
+P) на стандартной панели инструментов.



 
 
 

Рис. 1.16. Диалоговое окно вывода на печать простран-
ства модели

В диалоговом окне Plot – Model делаются следующие на-
значения.

• В области Page setup устанавливается набор параметров
листа. Кнопкой Add… открывается диалоговое окно добав-
ления набора параметров листа.

• В области Printer/plotter устанавливаются параметры:
– из списка Name: выбирается устройство вывода;
– кнопка Properties… загружает редактор параметров



 
 
 

плоттера;
– установкой флажка Plot to file назначается печать в

файл.
• В области Paper size определяется формат.
• В области Number of copies устанавливается количество

экземпляров.
• В области Plot area устанавливается печатаемая область:

Display – экран, Limits – лимиты, Window – область, выбран-
ная рамкой.

• В области Plot offset (origin set to printable area) опреде-
ляется смещение печатаемой области по X и Y, а также цен-
трированность.

• В области Plot scale определяется масштаб печати и веса
линий:

– Fit to paper – вписать;
– Scale: – масштаб;
– Scale lineweights – масштабировать веса линий.
• В области Plot style table (pen assignments) определяется

таблица стилей печати.
• В области видовых экранов с раскрашиванием Shaded

viewport options определяется:
– Shade plot – способ вывода (как на экране, каркас, скры-

тие линий; 3D-скрытый, 3D-каркас, концептуальный, реали-
стичный; тонирование, черновое, низкое, среднее, высокое,
презентационное);

– Quality – качество (черновое, просмотр, нормальное,



 
 
 

презентационное, максимум, пользовательское).
• В области Plot options определяются параметры печати:
– Plot in background – печатать в фоновом режиме;
– Plot object lineweights – учитывать веса линий;
– Plot with plot styles – учитывать стили печати;
– Plot paperspace last – объекты листа последними;
– Hide paperspace objects – скрывать объекты листа;
– Plot stamp on – включить штемпель;
– Save changes to layout – сохранить параметры.
• В области Drawing orientation определяется ориентация

чертежа:
– Portrait – книжная;
– Landscape – альбомная;
– Plot upside-down – перевернутая.
• Кнопка Preview… загружает окно предварительного

просмотра.



 
 
 

 
Выход из AutoCAD

 
Для выхода из AutoCAD используется команда QUIT, ко-

торая вызывается из падающего меню File → Exit CTRL+Q.
Команда позволяет сохранить или проигнорировать сде-

ланные в рисунке изменения и выйти из AutoCAD. Если
все выполненные изменения сохранены, при выходе из про-
граммы не появится никаких дополнительных сообщений. В
противном случае на экран будет выведено диалоговое ок-
но AutoCAD (рис. 1.17), предлагающее пользователю выбор:
сохранить изменения, отказаться от них или продолжить се-
анс работы. Если текущему рисунку не было присвоено имя
и вы хотите его сохранить, откроется диалоговое окно Save
Drawing As – см. рис. 1.14.

Рис. 1.17. Диалоговое окно сохранения изменений в ри-
сунке



 
 
 

 
Глава 2

Пользовательский
интерфейс AutoCAD

 
Падающие меню
Панели инструментов
Стандартная панель инструментов
Панель стилей
Панель рабочих пространств
Панель слоев
Панель свойств объектов
Строка состояния
Окно командных строк
Текстовое окно
Экранное меню
Функциональные клавиши
Контекстное меню
Инструментальные палитры
Центр управления AutoCAD DesignCenter
Просмотр и поиск содержимого

На рис. 2.1. показан классический рабочий стол AutoCAD
для Windows.



 
 
 

Рис. 2.1. Рабочий стол AutoCAD

В данный рабочий стол включены:
• падающие меню Menu Browser – меню, появляющееся

при щелчке кнопкой мыши на кнопке A в верхнем левом
углу окна программы (рис. 2.2);

• необязательные панели инструментов:
– стандартная панель Standard и панель стилей Styles –

верхняя строка окна программы;
– панель рабочих пространств Workspaces, слоев Layers и

свойств Properties – вторая строка;
– панель рисования Draw, а также редактирования Modify



 
 
 

– столбцы слева и справа;
– инструментальная палитра Tool Palettes – в правой части

окна приложения;
• строка состояния – строка внизу окна программы;
• окно командных строк – выше строки состояния;
• графическое поле , занимающее остальную часть рабоче-

го стола.

Рис. 2.2. Падающее меню



 
 
 

 
Падающие меню

 
Строка падающих меню может быть изменена путем до-

бавления либо удаления тех или иных пунктов. Для это-
го необходимо выбрать в падающем меню пункты Tools
→ Customize → Interface…, в появившемся диалоговом
окне настройки интерфейса пользователя Customize User
Interface на вкладке Customize, в области Customizatios in
All CUI Files раскрыть пункт Menus (рис. 2.3). Далее уста-
новить указатель мыши на один из пунктов меню и, нажав
правую кнопку мыши, вызвать контекстное меню, в котором
выбрать соответствующий пункт для удаления имеющихся
или создания новых падающих меню.



 
 
 

Рис. 2.3. Диалоговое окно адаптации меню

Строка падающих меню по умолчанию содержит следую-
щие пункты:

• File – команды работы с файлами: создание, открытие,
сохранение, публикация в Интернете, печать, экспорт фай-
лов в другие форматы, а также диспетчеры параметров ли-



 
 
 

стов, плоттеров, стилей печати и пр.;
• Edit – инструменты для редактирования частей графи-

ческого поля рабочего стола программы, работы с буфером
обмена и пр.;

• View – управление экраном, зумирование, панорамиро-
вание, установка трехмерной точки зрения, создание видо-
вых экранов и именованных видов, установка визуальных
стилей, тонирование, анимация траектории перемещения,
установка необходимых панелей инструментов;

• Insert – команды вставки блоков, внешних объектов,
объектов других приложений;

• Format – команды работы со слоями и их инструмента-
ми; цветом, типами линий; управление стилями текста, раз-
меров, мультилиний, таблиц; видом маркера точки, установ-
ки единиц измерения, границ чертежа;

• Tools – управление рабочими пространствами; палит-
рами; установка порядка прорисовки объектов и получение
сведений о них; работа с блоками и их атрибутами; рабо-
та с языком AutoLISP; работа с пользовательской системой
координат; настройка стандартов оформления; управление
Мастерами (публикации в Интернете, установки плоттеров,
создания таблиц стилей печати, цветозависимых стилей пе-
чати, компоновки листа, создания подшивки, импорта пара-
метров печати); установка параметров черчения и привязок
с помощью диалоговых окон и пр.;

• Draw – команды двумерного и трехмерного рисования;



 
 
 

• Dimension – команды простановки размеров и управле-
ния параметрами размерных стилей;

• Modify – команды редактирования элементов чертежа;
• Window – многооконный режим работы с чертежами;
• Help – вывод на экран системы гипертекстовых подска-

зок.



 
 
 

 
Панели инструментов

 
Команды AutoCAD на панелях инструментов представле-

ны в виде пиктограмм. Если задержать указатель мыши на
пиктограмме, рядом с ней появляется название соответству-
ющей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен ма-
ленький черный треугольник, это значит, что она содержит
подменю с набором родственных команд. Для вызова подме-
ню необходимо на некоторое время задержать на пиктограм-
ме указатель мыши, нажав ее левую кнопку.

Панели инструментов могут быть плавающими (float) или
закрепленными (dock), с фиксированным местоположени-
ем. Допускаются изменения размеров плавающих панелей,
а также их перемещение по графическому полю (рис. 2.4).
Плавающую панель можно сделать закрепленной, перетащив
ее с помощью мыши за пределы графического поля. И на-
оборот, как только закрепленная панель попадает в область
графического поля, она превращается в плавающую.

Рис. 2.4. Плавающая панель инструментов

При необходимости требуемую панель инструментов
можно вывести на рабочий стол, щелкнув левой кнопкой



 
 
 

мыши на ее имени в списке контекстного меню. Для полу-
чения этого контекстного меню необходимо щелкнуть пра-
вой кнопкой мыши, установив ее указатель на любую пикто-
грамму панелей инструментов (рис. 2.5).



 
 
 



 
 
 

Рис. 2.5. Список панелей инструментов

Для удаления панели инструментов необходимо сделать
ее плавающей, если она закреплена, и щелкнуть на кнопке
закрытия, расположенной в правом верхнем углу заголовка
панели.

Если набор необходимых панелей и окон упорядочен на
рабочем столе, во избежание их случайного перемещения
или удаления пользователь может зафиксировать их положе-
ние. Для этого следует вызвать контекстное меню щелчком
правой кнопки мыши на инструменте, изображающем замо-
чек в правом углу строки состояния, и зафиксировать поло-
жение панелей:

• Floating Toolbars/Panels – плавающие панели инструмен-
тов;

• Docked Toolbars/Panels – закрепленные панели инстру-
ментов;

• Floating Windows – плавающие окна;
• Docked Windows – закрепленные окна;
• All – все инструменты: Locked – заблокированы,

Unlocked – разблокированы;
• Help – справка.
Чтобы временно разблокировать панели инструментов,



 
 
 

необходимо удерживать нажатой клавишу Ctrl.



 
 
 

 
Стандартная панель инструментов

 
Стандартная панель Standard показана на рис. 2.6.

Рис. 2.6. Стандартная панель инструментов

Она содержит следующие инструменты:

QNew – создание нового файла рисунка;

Open… (Ctrl+О) – загрузка существующего файла;

Save (Ctrl+S) – сохранение текущего файла;

Plot… (Ctrl+P) – вывод рисунка на плоттер, принтер или
в файл;



 
 
 

Plot Preview – предварительный просмотр чертежа перед
выводом на печать, позволяющий увидеть размещение чер-
тежа на листе бумаги;

Publish… – публикация листов чертежа в формате фай-
ла Design Web Format (DWF), загрузка диалогового окна
Publish;

3DDWF – экспорт трехмерной модели в формате файла
Design Web Format (DWF);

Cut (Ctrl+X) – копирование объектов в буфер обмена с
удалением их из рисунка;



 
 
 

Copy (Ctrl+C) – копирование выбранных элементов чер-
тежа в буфер Windows без удаления их из исходного доку-
мента;

Paste (Ctrl+V) – вставка данных из буфера Windows;

Match Properties – копирование свойств заданного объек-
та другому объекту;

Block Editor – редактирование блоков;

Undo (Ctrl+Z) – отмена последнего действия;

Redo (Ctrl+Y) – восстановление только что отмененного
действия;



 
 
 

Pan Realtime – перемещение изображения на текущем ви-
довом экране в режиме реального времени;

Zoom Realtime – увеличение или уменьшение видимого
размера объектов на текущем видовом экране в режиме ре-
ального времени;

Подменю Zoom – раскрывающийся набор инструментов,
в котором можно задать различные способы увеличения и
уменьшения видимого размера объектов на текущем видо-
вом экране;

Zoom Previous – возврат к показу предыдущего вида;



 
 
 

Properties (Ctrl+1) – загрузка палитры управления свой-
ствами объектов;

DesignCenter (Ctrl+2) – диалоговый интерфейс, позволя-
ющий быстро находить, просматривать, вызывать, перено-
сить в текущий рисунок ранее созданные рисунки, управлять
вхождениями блоков, внешними ссылками и другими эле-
ментами рисунков, такими как слои, листы и текстовые сти-
ли;

Tool Palettes Window (Ctrl+3) – инструментальные палит-
ры в виде отдельных вкладок специального окна, которые
служат эффективным средством хранения/вставки блоков и
штриховки. Палитры могут содержать инструменты, предо-
ставленные сторонними разработчиками;

Sheet Set Manager (Ctrl+4) – диспетчер подшивок наборов
листов, позволяющий организовать размещение пакетов ли-
стов в зависимости от типа чертежей и с возможностью эф-
фективного создания, управления и совместного использо-



 
 
 

вания наборов логически связанных рисунков;

Markup Set Manager (Ctrl+7) – диспетчер наборов поме-
ток, позволяющий организовать работу с рисунками форма-
та DWF;

QuickCalc (Ctrl+8) – калькулятор;

Help – вызов справочной системы.



 
 
 

 
Панель стилей

 
Панель стилей Styles, показанная на рис. 2.7, предназна-

чена для создания новых текстовых, размерных и табличных
стилей.

Рис. 2.7. Панель стилей

Панель содержит следующие инструменты:

Text Style… – создание новых и редактирование имею-
щихся текстовых стилей;

Dimension Style… – создание новых и редактирование
имеющихся размерных стилей;

Table Style… – создание новых и редактирование имею-
щихся табличных стилей;



 
 
 

Multileader Style… – создание новых и редактирование
имеющихся стилей линий-выносок.



 
 
 

 
Панель рабочих пространств

 
Панель Workspaces, показанная на рис. 2.8, позволяет за-

давать параметры рабочих пространств.

Рис. 2.8. Панель рабочих пространств

Рабочие пространства включают только необходимые на-
боры меню, инструментальные панели и палитры, сгруппи-
рованные и упорядоченные соответственно решаемой за-
даче. Элементы интерфейса, не являющиеся необходимы-
ми для решения текущей задачи, скрываются, максимально
освобождая область экрана, доступную для работы.

В AutoCAD определены следующие рабочие простран-
ства:

• 2D Drafting & Annotation – двумерное моделирование



 
 
 

(рис. 2.9);

Рис. 2.9. Рабочее пространство для двумерного модели-
рования

• 3D Modeling – трехмерное моделирование (рис. 2.10);



 
 
 

Рис. 2.10. Рабочее пространство для трехмерного моде-
лирования

• AutoCAD Classic – классический AutoCAD (см. рис.
2.1).

Помимо возможности установить рабочее пространство,
в панель Workspaces включены следующие пункты:

• Save Current As… – открытие диалогового окна Save
Workspace, позволяющего сохранить текущее рабочее про-
странство;

• Workspace settings… – открытие диалогового окна
Workspace Settings, позволяющего настроить текущие пара-



 
 
 

метры рабочего пространства для последующего использо-
вания;

• Customize… – открытие диалогового окна Customize
User Interface, позволяющего осуществить настройки интер-
фейса пользователя.

А также панель Workspaces содержит следующие инстру-
менты:

Workspace Settings… – открытие диалогового окна
Workspace Settings, позволяющего настроить текущие пара-
метры рабочего пространства для последующего использо-
вания;

My Workspace – возвращение имени текущего рабочего
пространства в интерфейс командной строки и установление
этого пространства текущим.

Рабочее пространство 3D Modeling включает новый пульт
управления, обеспечивающий удобный доступ к новым
функциям трехмерного моделирования. В области рисова-
ния отображается цвет фона, наземная плоскость или рабо-
чая поверхность и новая прямоугольная сетка, что улучшает
трехмерную визуализацию и облегчает создание простран-



 
 
 

ственных моделей. Новый трехмерный курсор обеспечива-
ет указание направления ПСК. Вкладки Model и Lauout за-
менены кнопками в строке состояния, благодаря чему рас-
ширена область рисования. На режим отображения вкладок
можно переключиться, щелкнув правой кнопкой мыши на
кнопке Model или Lauout.



 
 
 

 
Панель слоев

 
Панель слоев Layers, показанная на рис. 2.11, обеспечи-

вает работу со слоями.

Рис. 2.11. Панель слоев

В нее входят следующие инструменты:

Layer Properties Manager – вызов Диспетчера свойств сло-
ев Layer Properties Manager;

Layer Control – раскрывающийся список управления слоя-
ми. Каждая строка содержит пиктограммы управления свой-
ствами слоя или отображения его свойств, а также его имя.
Ниже перечисляются эти пиктограммы (слева направо):

– Turn a layer On or Off – включение/отключение слоя;
– Freeze or thaw in ALL viewports – замораживание/раз-

мораживание на всех видовых экранах;
– Freeze or thaw in current viewport – замораживание/раз-



 
 
 

мораживание на текущем видовом экране;
– Lock or Unlock a layer – блокирование/разблокирование

слоя;
– Color of layer – цвет слоя;
– Layer Control – имя слоя.

Make Object's Layer Current – установка текущего слоя в
соответствии со слоем выбранного примитива;

Layer Previous – возврат к предыдущему состоянию слоев;

Layer States Manager – загрузка диалогового окна Layer
States Manager.



 
 
 

 
Панель свойств объектов

 
Панель свойств объектов Properties, показанная на рис.

2.12, предназначена для работы с цветом, типом и весом ли-
ний.

Рис. 2.12. Панель свойств объектов

В нее входят следующие инструменты:

Color Control – раскрывающийся список установки теку-
щего цвета, а также изменения цвета выбранных объектов;

Line Type Control – раскрывающийся список установки
текущего типа линии, а также изменения типа линии для вы-
бранных объектов;

Line Weight Control – раскрывающийся список установки



 
 
 

текущего веса (толщины) линии, а также изменения толщи-
ны линий выбранных объектов;

Plot Styles Control – раскрывающийся список установки
стилей печати. Здесь можно изменять внешний вид вычер-
чиваемого на плоттере рисунка.

В стилях печати при необходимости переопределяются
цвета, типы и веса (толщины) линий объектов. Кроме это-
го, имеется возможность указывать используемые при печа-
ти стили концов линий, соединений и заполнений, а также
различные выходные эффекты – размывание, оттенки серо-
го, присвоения перьев и интенсивность. Манипулируя сти-
лями печати, можно получить на бумаге различные вариан-
ты одного и того же рисунка. Допускается применение сти-
лей печати к объектам или слоям.



 
 
 

 
Строка состояния

 
Строка состояния (рис. 2.13) расположена в нижней части

рабочего стола.

Рис. 2.13. Строка состояния

Она содержит текущие координаты курсора, а также кноп-
ки включения/выключения режимов черчения:

Snap Mode – включение и выключение шаговой привязки
курсора;

Grid Display – включение и выключение отображения сет-
ки;

Ortho Mode – включение и выключение ортогонального
режима;



 
 
 

Polar Tracking – включение и выключение режима поляр-
ного отслеживания;

Object Snap – включение и выключение режимов объект-
ной привязки;

Object Snap Tracking – включение и выключение режима
отслеживания при объектной привязке;

Allow/Disallow Dynamic UCS – включение и выключение
динамической пользовательской системы координат;

Dynamic Input – включение и выключение динамического
ввода;



 
 
 

Show/Hide Lineweight – включение и выключение режима
отображения линий в соответствии с весами (толщинами);

Quick Properties – включение и выключение свойств объ-
ектов;

Model or Paper space – переключение из пространства мо-
дели в пространство листа;

Quick View Layouts – включение и выключение просмотра
листов;

Quick View Drawins – включение и выключение просмот-
ра рисунков;



 
 
 

Pan – панорамирование рисунка;

Zoom – зумирование рисунка;

SteeringWheel – включение инструмента Wheel;

ShowMotion – включение инструмента Motion.

Отображение кнопок включения/выключения режимов
черчения в строке состояния устанавливается в контекстном
меню (рис. 2.14). Для этого необходимо щелкнуть левой или
правой кнопкой на находящемся в правом углу строки со-
стояния инструменте Status Bar menu с изображением стрел-
ки, направленной вниз.



 
 
 

Рис. 2.14. Контекстное меню настройки строки состояния

Команда Tray Settings… открывает диалоговое окно Tray
Settings (рис. 2.15), позволяющее произвести настройку об-
ласти уведомлений:



 
 
 

• Display icons from services – показывать значки служб;
• Display notifications from services – показывать уведом-

ления от служб:
– Display time – время отображения;
– Display until closed – до явного закрытия.

Рис. 2.15. Диалоговое окно настройки области уведомле-
ний



 
 
 

 
Окно командных строк

 
Окно командных строк обычно расположено над строкой

состояния; оно служит для ввода команд и вывода подсказок
и сообщений AutoCAD. Размеры окна, а следовательно, ко-
личество выводимых строк протокола можно изменять. При
наличии в окне команд более одной строки перемещение по
строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по шири-
не окну AutoCAD (рис. 2.16). Если текстовая строка не по-
мещается в окне, ее полное содержимое выводится в рамке
вблизи командной строки.

Рис. 2.16. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной
полосы, находящейся в его верхней части (если оно закреп-
лено внизу) или в нижней (если оно закреплено вверху). Что-
бы изменить размер, следует захватить разделительную по-
лосу с помощью мыши и «отбуксировать» ее до требуемой
высоты.

Окно может быть как закрепленным, так и плавающим.
Закрепление отменяется путем выбора рамки окна в любом
месте и последующей буксировки за пределы зоны закреп-



 
 
 

ления до тех пор, пока граница окна не примет вид широ-
кой контурной линии. Если отпустить окно в этот момент,
оно станет плавающим и приобретет размер, который имело
до закрепления. Плавающее окно может быть перемещено в
любую позицию экрана; при этом пользователю разрешено
изменять его ширину и высоту (рис. 2.17).

Рис. 2.17. Плавающее окно командных строк

Закрепляется окно команд путем «буксировки» к верхней
или нижней зоне закрепления окна AutoCAD.

В окне командных строк можно прокручивать текст, вы-
полнять его редактирование и повторно вводить команды.
Для этого используются стандартные клавиши: ↑, ↓, ←, →,
Insert, Delete, Home, End, Page Up, Page Down, Backspace.

При повторении ранее введенных команд удобно восполь-
зоваться комбинацией клавиш Ctrl+C, чтобы копировать вы-
деленный текст в буфер обмена, и Ctrl+V, чтобы вставить
содержимое буфера в текстовое окно или окно команд.

Щелчок правой кнопкой мыши в области окна командных
строк или текстового окна AutoCAD вызывает контекстное
меню, куда входят шесть последних использованных команд,



 
 
 

функции копирования выделенного текста или всего прото-
кола команд, вставки текста, а также вызова диалогового ок-
на настройки Options.



 
 
 

 
Текстовое окно

 
Просмотреть большую часть протокола команд – так на-

зываемую историю команд (command history) – можно, пе-
реключившись в текстовое окно, показанное на рис. 2.18.
Оно вызывается нажатием функциональной клавиши F2 или
командой TEXTSCR, а также из падающего меню View →
Display → Text Window F2.

Рис. 2.18. Текстовое окно

Текстовое окно подобно окну команд: в нем также можно



 
 
 

вводить команды, наблюдать подсказки и сообщения, выда-
ваемые AutoCAD. Для перемещения по окну используются
полоса прокрутки или клавиши ↑, ↓, ←, →, Page Up и пр.

Содержимое текстового окна предназначено только для
чтения и не подлежит изменению. Но протокол команд мож-
но копировать для последующей вставки в командную стро-
ку или текстовый редактор.



 
 
 

 
Экранное меню

 
В AutoCAD 2009 сохраняется возможность отображения

экранного меню. Его включение и отключение выполняют-
ся на вкладке Display диалогового окна Options, загружа-
емого из падающего меню Tools → Options…. Достаточно
установить или снять флажок Display screen menu в области
Window Elements.

Экранное меню AutoCAD имеет иерархическую структу-
ру. Используя переходы в различные подменю, можно пере-
двигаться по дереву меню. Для перехода к корню дерева слу-
жит верхняя строка экранного меню, где всегда находится
слово AutoCAD.



 
 
 

 
Функциональные клавиши

 
Для удобной работы с системой сохраняется возможность

использования функциональных клавиш:
• F1 – вызов справочной системы AutoCAD;
• F2 – переключение между текстовым и графическим ок-

нами;
• F3 или Ctrl+F – включение/отключение текущих режи-

мов объектной привязки OSNAP;
• F4 – переключение системной переменной TABMODE;
• F5 или Ctrl+E – циклическое переключение изометри-

ческих плоскостей;
• F6 или Ctrl+D – включение/отключение динамических

ПСК, переключение системной переменной UCSDETECT;
• F7 или Ctrl+G – включение/отключение отображе-

ния сетки GRID, переключение системной переменной
GRIDMODE;

• F8 или Ctrl+L – включение/отключение ортогонального
режима построений ORTHO, переключение системной пе-
ременной ORTHOMODE;

• F9 или Ctrl+B – включение/отключение шаговой
привязки SNAP, переключение системной переменной
SNAPMODE;

• F10 – включение/отключение режима полярного отсле-
живания POLAR;



 
 
 

• F11 – включение/отключение режима отслеживания
объектной привязки OTRACK;

• F12 – включение/отключение динамического ввода
DYN;

• Esc или Ctrl+[, Ctrl+\ – прерывание текущей команды;
• Enter, Ctrl+M или Ctrl+J – повторное выполнение по-

следней команды;
• Ctrl+A – выбор группы объектов;
• ALT+ F11 – вызов редактора Visual Basic;
• ALT+ F8 – вызов диалогового окна Macros;
• Ctrl+C – копирование объектов в буфер обмена

Windows;
• Ctrl+H – включение/отключение системной переменной

PICKSTYLE;
• Ctrl+I – включение/отключение системной переменной

COORDS;
• Ctrl+N – создание нового чертежа, открытие диалогово-

го окна Create New Drawing;
• Ctrl+O – открытие существующего файла чертежа и диа-

логового окна Select File;
• Ctrl+P – вывод текущего чертежа на печать, открытие

диалогового окна Plot – Model;
• Ctrl+R – циклическое переключение между видовыми

экранами листов;
• Ctrl+S – сохранение текущего рисунка;
• Ctrl+T – включение и отключение режима Планшет;



 
 
 

• Ctrl+V – вставка объектов из буфера обмена данных в
текущий чертеж;

• Ctrl+X – удаление выбранных объектов из чертежа и ко-
пирование их в буфер обмена данными;

• Ctrl+Y – восстановление только что отмененного дей-
ствия;

• Ctrl+Z – отмена последней команды;
• Ctrl+ Shitf+A – включение/отключение групп;
• Ctrl+ Shitf+C – копирование объектов в буфер обмена с

базовой точкой;
• Ctrl+ Shitf+S – вызов диалогового окна Save Drawing As;
• Ctrl+ Shitf+V – вставка данных из буфера обмена в виде

одного блока;
• Ctrl+ Page Up – перемещение на следующую вкладку

слева от текущей;
• Ctrl+ Page Down – перемещение на следующую вкладку

справа от текущей;
• Ctrl+0 – включение/отключение режима чистого экрана;
• Ctrl+1 – включение/отключение палитры управления

свойствами объектов;
• Ctrl+2 – включение/отключение Центра управления

DesignCenter;
• Ctrl+3 – открытие/закрытие окна инструментальных па-

литр;
• Ctrl+4 – включение/отключение диспетчера подшивок

наборов листов;



 
 
 

• Ctrl+5 – включение/отключение информационной па-
литры INFO;

• Ctrl+6 – включение/отключение диспетчера подключе-
ния к базам данных, загрузка палитры dbConnect Manager;

• Ctrl+7 – включение/отключение диспетчера наборов по-
меток;

• Ctrl+8 – включение/отключение палитры калькулятора;
• Ctrl+9 – включение/отключение окна команд.



 
 
 

 
Контекстное меню

 
Для выбора пунктов меню и пиктограмм на панели ин-

струментов часто используется устройство указания – мышь.
При работе с мышью щелчок левой кнопкой в области рисо-
вания обычно используется для выбора и указания точки на
экране; щелчок правой кнопкой мыши вызывает контекст-
ное меню, которое обеспечивает быстрый доступ к командам
(см. рис. 2.4, 2.19). Форма и содержание меню зависят от по-
ложения указателя мыши и состояния задачи.



 
 
 

Рис. 2.19. Пример контекстного меню

При щелчке правой кнопкой мыши в области рисования
вызывается одно из шести контекстных меню:

• стандартное – вызывается при отсутствии выбранных
объектов и активных команд. Содержит последнюю исполь-
зуемую команду, набор стандартных функций, предназна-



 
 
 

ченных, в частности, для работы с буфером обмена, команды
зумирования, панорамирования, а также вызов диалогового
окна настройки рабочей среды Options;

• команда – вызывается при выполнении какой-либо ко-
манды. Содержит набор ключей, отображаемых в командной
строке, облегчающих выполнение текущей команды с помо-
щью мыши;

• объектная привязка – вызывается при щелчке правой
кнопкой мыши и одновременном нажатии клавиши Shift.
Позволяет выбрать или настроить режимы объектной при-
вязки и включить координатный фильтр;

• редактирование – вызывается при выбранном одном
или нескольких объектах и отсутствии активных команд.
Объединяет функции, предназначенные для редактирова-
ния объектов. Набор функций может изменяться в зависи-
мости от типа выбранного объекта;

• ручки – вызывается при выделенной на объекте актив-
ной ручке. Содержит функции, позволяющие проводить ре-
дактирование с помощью ручек;

• OLE – вызывается при щелчке правой кнопкой мыши на
вставленном в рисунок OLE-объекте. Объединяет функции,
позволяющие редактировать OLE-объекты.

Контекстные меню объектная привязка, ручки и OLE все-
гда включены, а потому их можно вызывать в любой мо-
мент. Контекстные же меню стандартное, редактирование
и команда можно отключить. В этом случае щелчок пра-



 
 
 

вой кнопкой мыши будет соответствовать нажатию клави-
ши Enter. По умолчанию вызов этих трех контекстных меню
включен.

Для других элементов окна AutoCAD, кроме области ри-
сования, можно вызывать следующие контекстные меню:

• панель инструментов – вызывается щелчком правой
кнопки мыши на свободной области правее стандартной па-
нели инструментов или на одном из инструментов. Содер-
жит список панелей и предназначена для их включения/от-
ключения или настройки;

• командная строка – вызывается щелчком правой кноп-
ки мыши на командной строке или в окне команд. Содер-
жит список из шести команд, выполнявшихся последними,
и служит для вызова некоторых функций, используемых при
работе с командной строкой;

• диалоговое окно – вызывается щелчком правой кнопки
мыши на элементе диалогового окна. Доступно не для всех
диалоговых окон и, как правило, связано либо с раскрываю-
щимися списками, либо с полями для ввода значений и поз-
воляет удалять, переименовывать отдельные пункты списка
или работать с буфером обмена;

• строка состояния – вызывается щелчком правой кноп-
ки мыши на области строки состояния, где выводятся теку-
щие координаты, либо на любой кнопке переключения ре-
жимов рисования или изменения настроек. Служит для пе-
реключения режимов рисования или изменения их настро-



 
 
 

ек;
• вкладки Model/Layout – вызывается щелчком правой

кнопки мыши на вкладке Model или одной из вкладок
Layout. Используется для вызова окон печати и настройки
параметров страницы, а также управления листами.



 
 
 

 
Инструментальные палитры

 

Инструментальные палитры загружаются командой
TOOLPALETTES из падающего меню Tools → Palettes →
Tool Palettes (CTRL+3) либо щелчком на пиктограмме Tool
Palettes Window (Ctrl+3) на стандартной панели инструмен-
тов.

Инструментальные палитры представляют собой отдель-
ные вкладки, объединенные в специальном окне Tool Palettes
(рис. 2.20), и являются эффективным средством хранения
и вставки блоков и штриховки, а также могут содержать ин-
струменты, предоставленные сторонними разработчиками.



 
 
 



 
 
 

Рис. 2.20. Инструментальная палитра

В разных областях окна инструментальных палитр с по-
мощью контекстных меню можно изменять следующие на-
стройки:

• автоматически убирать палитры с экрана – окно инстру-
ментальных палитр может автоматически разворачиваться и
сворачиваться при подведении указателя мыши к строке за-
головка окна и отведении от нее;

• прозрачность – окно палитры инструментов делается
прозрачным и не скрывает находящиеся за ним объекты (эта
функция недоступна для пользователей Microsoft Windows
NT);

• вид – изменяются стиль и размер отображаемых в па-
литре значков.

Окно инструментальных палитр при необходимости мож-
но закрепить у правой или левой границы окна программы.
Для того чтобы избежать закрепления, при перемещении ок-
на следует удерживать нажатой клавишу Ctrl.

На палитрах удобно размещать часто используемые блоки
и штриховки. Для того чтобы вставить блок или штриховку
c палитры в рисунок, необходимо «захватить» элемент па-
литры с помощью мыши и перетащить его в графическую
область.

Блоки и штриховки, размещенные на палитре, носят на-
звание «инструменты». Некоторые свойства инструментов,



 
 
 

включая масштаб, угол поворота и слой, могут устанавли-
ваться отдельно для каждого инструмента.

Блоки, вставляемые в рисунок с палитр, часто требуется
масштабировать и поворачивать. При перетаскивании бло-
ков с палитры можно использовать объектную привязку, од-
нако шаговая привязка в это время не действует.

При перетаскивании блока с инструментальной палитры
на рисунок он автоматически масштабируется в зависимости
от соотношения заданных единиц блока и единиц текущего
рисунка. Например, если в качестве единиц измерения дан-
ного рисунка используются метры, а в качестве единиц из-
мерения блока – сантиметры, то коэффициент пересчета со-
ставляет 1:100. Соответственно при перетаскивании блока в
рисунок его размеры меняются в пропорции 1:100.

Для добавления инструментов на палитру можно:
• перетаскивать рисунки, блоки и штриховки из Центра

управления на инструментальную палитру. Если туда зане-
сен целый рисунок, то при перетаскивании с палитры в гра-
фическую область он вставляется как блок;

• перетаскивать на палитру элементы чертежа;
• перемещать и копировать инструменты с одной палитры

на другую при помощи команд контекстного меню Cut – вы-
резать, Copy – копировать и Paste – вставить;

• перетаскивать на палитру команды из области Command
List: диалогового окна Customize User Interface.

Можно создать новую палитру. Чтобы она сразу оказа-



 
 
 

лась заполнена инструментами, необходимо щелкнуть пра-
вой кнопкой мыши на папке, файле рисунка или блоке в
Центре управления, а затем выбрать из контекстного меню
пункт Create Tool Palette.

Порядок размещения инструментов на палитре изменяет-
ся в результате перетаскивания их с помощью мыши.

Если в нижнем углу палитры высвечивается значок замка,
это значит, что файлу инструментальной палитры присвоен
атрибут только чтения Read only.

Настройки инструментальных палитр сохраняются в про-
филе AutoCAD. А экспортируются и импортируются палит-
ры как файлы с расширением XTP.

Для изменения свойств инструментов, например масшта-
ба блока и угла поворота образца штриховки, необходи-
мо щелкнуть правой кнопкой мыши на инструменте, а за-
тем выбрать из контекстного меню пункт свойств объекта
Properties…. Далее в диалоговом окне свойств инструмента
Tool Properties изменяются свойства (рис. 2.21):

• название инструмента и пояснение к нему;
• параметры вставки или образца – угол поворота, мас-

штаб;
• общие свойства – слой, цвет, тип линий и стиль печати.



 
 
 



 
 
 

Рис. 2.21. Диалоговое окно свойств инструментов палит-
ры



 
 
 

 
Центр управления

AutoCAD DesignCenter
 

В практической деятельности очень важно иметь возмож-
ность использовать созданные ранее наработки: опыт пока-
зывает, что большинство проектно-конструкторских проек-
тов создается на базе новых сочетаний элементов, давно из-
вестных как по принципу функционирования, так и по ис-
полнению. AutoCAD обеспечивает эффективное повторное
использование имеющихся наработок путем их вставки в ри-
сунки в виде блоков или внешних ссылок. Управлять бло-
ками, внешними ссылками, растровыми изображениями и
содержимым рисунков, находящихся в других источниках
(и даже подготовленных в других приложениях), позволяет
Центр управления AutoCAD DesignCenter.

Кроме того, если в сеансе открыто несколько рисунков,
Центр управления дает возможность упростить процесс со-
здания таких элементов, как, например, описания одних и
тех же слоев. Пользователь создает описание в одном рисун-
ке, а затем просто копирует в остальные.

Центр управления DesignCenter предназначен для орга-
низации доступа к чертежам и их элементам и обеспечивает:

• просмотр содержимого чертежей на локальном диске,
сетевом диске и веб-страницах;

• просмотр и вставку в текущий чертеж блоков, слоев, тек-



 
 
 

стовых и размерных стилей, типов линий, внешних ссылок,
образцов штриховки и прочих элементов чертежей;

• доступ к растровым изображениям и сторонним объек-
там, созданным в других приложениях;

• обновление описания блоков;
• перетаскивание элементов чертежа на инструменталь-

ные палитры.
Центр управления AutoCAD загружается командой

ADCENTER, либо из падающего меню Tools → Palettes
→ DesignCenter (Ctrl+2), либо щелчком на пиктограмме
DesignCenter (Ctrl+2) на стандартной панели инструментов
(рис. 2.22).

Рис. 2.22. Центр управления DesignCenter



 
 
 

Центр управления имеет интуитивно понятный интер-
фейс и позволяет быстро находить, просматривать, вызывать
и применять специфические компоненты, такие как блоки,
слои, типы линий и пр. Причем эти операции осуществля-
ются из открытых или закрытых файлов AutoCAD независи-
мо от того, где они находятся: на локальных или удаленных
дисках. Достаточно просто выбрать нужные компоненты и
перетащить их в текущий рисунок.

Панель инструментов, расположенная вверху Центра
управления DesignCenter, обеспечивает доступ к набору ре-
жимов и операций, а также осуществляет навигацию внутри
окна и просмотр информации в области структуры и содер-
жимого. Область структуры находится слева, в ней отобра-
жаются источники содержимого. Справа находится область
содержимого, предназначенная для добавления элементов
в чертеж или на инструментальную палитру. Область про-
смотра образца и пояснений к нему расположена справа вни-
зу окна.

Центр управления включает следующие вкладки:
• Folders – вкладка, отображающая дерево иерархической

структуры папок. Если слева, в области структуры, с помо-
щью мыши выбрать элемент, то справа отобразится его со-
держимое;

• Open Drawings – вкладка, отображающая список черте-
жей, открытых в текущий момент. Для того чтобы справа,
в области содержимого, отобразить элементы, необходимо



 
 
 

слева, в области структуры, выбрать файл чертежа, а затем
из списка – одну из таблиц описаний;

• History – вкладка, отображающая список последних
файлов, открывавшихся с помощью Центра управления.
При двойном нажатии в списке на файле чертежа открыва-
ется папка Folders с этим чертежом и его элементами в об-
ласти содержимого;

• DC Online – интернет-модуль Центра управления, обес-
печивающий доступ к содержимому на веб-страницах, вклю-
чая блоки, библиотеки компонентов, библиотеки разработ-
чиков и интернет-каталоги.

Для добавления элементов из области содержимого в те-
кущий чертеж выбранный элемент достаточно перетащить в
графическую область чертежа либо воспользоваться одним
из вариантов, предлагаемых в контекстном меню. Также из
области содержимого Центра управления можно перетащить
чертежи, блоки и штриховки на текущую инструментальную
палитру.



 
 
 

 
Просмотр и поиск содержимого

 
Для просмотра элементов содержимого, находящихся в

текущем источнике, служит зона содержимого, или палит-
ра,  – средство AutoCAD, предназначенное для просмотра
содержимого открытых рисунков и других источников, а
также образцов и описаний перед вставкой идентифицируе-
мых ими объектов в рисунок. Кроме этого, палитра может
использоваться для поиска на диске файлов рисунков по их
содержимому.

Просматривать открытые рисунки, журнал предыдущих
рисунков, а также файлы и папки локального и сетевых дис-
ков можно в зоне структуры, которая является хорошим по-
мощником при перемещении по содержимому рисунка, но
ее присутствие на экране необязательно для загрузки палит-
ры.

На палитре отображаются крупные значки, а в зоне струк-
туры показана структура рабочего стола. Перемещаясь по
структуре, можно выбирать источники и загружать их содер-
жимое в палитру.

Ниже приводятся способы размещения Центра управле-
ния AutoCAD на рабочем столе:

• для изменения размеров окна следует захватить с помо-
щью мыши его границу, разделитель зон или ручку в правом
нижнем углу и перетащить ее в нужное положение;



 
 
 

• для освобождения окна нужно щелкнуть на его заголов-
ке, перетащить окно за пределы зоны закрепления и отпу-
стить кнопку мыши. Окно станет плавающим, и его можно
будет перемещать в любое место экрана;

• для закрепления окна нужно либо перетащить его в
одну из зон закрепления (в левой или правой части окна
AutoCAD), либо дважды щелкнуть кнопкой мыши по заго-
ловку плавающего окна. При перетаскивании окна никакие
особые действия по закреплению не нужны – оно закрепля-
ется само, достигнув крайней части области рисования.

В дополнение к поиску рисунков с нужными элементами
вручную путем перемещения по структуре Центр управле-
ния AutoCAD обеспечивает автоматический поиск рисун-
ков, описаний блоков и слоев, а также элементов сторонних
приложений по именам. Для этого используется инструмент
Search, при щелчке на котором открывается диалоговое ок-
но Search – рис. 2.23.



 
 
 

Рис. 2.23. Диалоговое окно поиска

Здесь можно настроить поиск по различным критериям, в
том числе по дате последнего изменения. Допускается также
поиск по фрагментам текста, содержащимся в текстовых
описаниях блоков или в полях свойств рисунка. Например,
если имя рисунка неизвестно, его можно найти по ключево-
му слову, заданному в свойствах. Если же пользователь же-
лает отыскать созданный им блок, но не помнит точно, как
он был сохранен (в рисунке или в отдельном файле), следу-
ет задать в качестве критерия имя блока, а из списка Look
for выбрать Drawings and Blocks. Выбранный тип опреде-



 
 
 

ляет вид вкладок диалогового окна. Далее необходимо вве-
сти в поле In начальный участок поиска или нажать кнопку
Browse… и выбрать его в структуре диска. Если поиск дол-
жен охватывать все уровни, подчиненные указанному, тре-
буется установить флажок для просматривания вложенных
папок Search subfolders.

Если в списке Look for выбран пункт Drawings, то в диало-
говом окне Search появляются три вкладки, на которых мож-
но задать различные критерии поиска:

• Drawings – имя или текст для поиска, возможно, вместе
с именем свойства. Разрешается задавать искомый текст и
указывать, к чему он относится (к названию файла, имени
автора и т. д.);

• Date Modified – дата или диапазон дат создания или по-
следнего изменения искомого элемента содержимого. Мо-
жет также задаваться в формате during the previous N
month(s) – за последние N месяцев или during the previous
N day(s) – за последние N дней. По умолчанию AutoCAD не
ограничивает поиск по дате;

• Advanced – дополнительные параметры поиска. Здесь
можно, например, настроить поиск рисунков, содержащих
некоторую текстовую строку (в именах блоков, именах или
значениях атрибутов, а также в текстовых описаниях элемен-
тов). Кроме того, предусмотрено ограничение поиска по ми-
нимальному или максимальному размеру файла. При поис-
ке допускается ввод как всей текстовой строки, так и отдель-



 
 
 

ного ее фрагмента. Можно также использовать глобальные
символы (* и ?).

Если в списке Look for выбрано значение, отличное от
Drawings, то в диалоговом окне Search появляется одна из
нижеперечисленных вкладок:

• Blocks – поиск блоков по именам;
• Dimstyles – поиск размерных стилей по именам;
• Drawings and Blocks – поиск рисунков и блоков по име-

нам;
• Hatch Pattern Files – поиск файлов образцов штриховки

по именам;
• Hatch Patterns – поиск образцов штриховки по именам;
• Layers – поиск слоев по именам;
• Layouts – поиск листов по именам;
• Linetypes – поиск типов линий по именам;
• Tablestyles – поиск табличных стилей по именам;
• Textstyles – поиск текстовых стилей по именам;
• Xrefs – поиск внешних ссылок по именам.
Для запуска механизма поиска следует нажать кнопку

Search Now. Записи о найденных элементах отображаются
в диалоговом окне по мере их обнаружения. Для нового по-
иска с другими критериями нужно воспользоваться кноп-
кой New Search. После щелчка на ней список с результатами
предыдущего поиска будет очищен.

Элемент содержимого, найденный во время поиска и за-
несенный в таблицу результатов, можно добавить в откры-



 
 
 

тый рисунок. Результат поиска также можно загрузить непо-
средственно на палитру Центра управления.

Для смены источника содержимого зоны структуры необ-
ходимо в Центре управления AutoCAD открыть одну из
следующих вкладок или выбрать их из контекстного меню,
щелкнув правой кнопкой мыши на свободной части палит-
ры:

• Folders – перечень локальных и сетевых дисков;
• Open Drawings – перечень рисунков, открытых в данный

момент в AutoCAD;
• History – перечень последних 20 элементов, открытых

через Центр управления AutoCAD;
• DC Online – подключение к Интернету.
Центр управления AutoCAD предоставляет очень про-

стой способ открытия файлов рисунков – пользователю до-
статочно всего лишь перетащить значок выбранного файла
в пустую часть области рисования. При этом следует быть
внимательным, так как перетаскивание значка не в пустую
часть, а в открытый рисунок приведет к другому результату.

Для перетаскивания необходимо, чтобы хотя бы часть об-
ласти рисования не была покрыта рисунками. Этого можно
достичь, уменьшив размеры открытых окон или свернув их.
Если при перетаскивании вывести указатель мыши за преде-
лы окна AutoCAD, он примет форму перечеркнутого круга
– значит, оставлять рисунок в этом месте нельзя.

Таким образом, с помощью Центра управления AutoCAD



 
 
 

можно:
• просматривать различные источники содержимого ри-

сунков, начиная с документов, открытых в текущем сеансе
AutoCAD, и вплоть до библиотек обозначений на веб-стра-
ницах;

• просматривать описания блоков, слоев и других элемен-
тов в любом файле рисунка, вставлять и копировать эти опи-
сания в текущий рисунок;

• создавать ярлыки для часто используемых рисунков, па-
пок и интернет-страниц;

• находить рисунки с нужным содержимым на локальном
и сетевых дисках. Так, например, можно разыскать рисунок,
в котором имеется слой с заданным именем, либо файл, со-
храненный до или после указанной даты. Найденный рису-
нок можно загрузить в Центр управления или перетащить
непосредственно в текущий документ;

• открывать рисунки путем перетаскивания DWG-файлов
с палитры в область рисования;

• просматривать и вставлять растровые изображения пу-
тем перетаскивания их файлов с палитры в область рисова-
ния;

• управлять представлением элементов палитры (крупные
или мелкие значки, список или таблица). Также предусмот-
рено отображение на палитре образцов и текстовых описа-
ний элементов рисунка.



 
 
 

 
Глава 3

Настройка рабочей среды AutoCAD
 

Определение доступа к файлам поддержки
Настройка параметров рабочего экрана
Настройка параметров открытия и сохранения

файлов
Определение параметров вывода на печать
Настройка системных параметров
Настройка пользовательской среды
Управление точностью построения объектов
Настройка параметров трехмерного моделирова-

ния
Настройка параметров выбора объектов
Настройка профилей

Пользователь имеет возможность изменять различные па-
раметры рабочей среды AutoCAD, влияющие на конфигура-
цию интерфейса и условия рисования. Такие настройки на-
зываются профилем. Пользователи, входящие в систему под
одним именем, могут загружать свои настройки из различ-
ных профилей. Целесообразно использование профилей для
сохранения настроек, присущих разным проектам.

Процедура настройки рабочей среды AutoCAD осуществ-



 
 
 

ляется в диалоговом окне Options, которое вызывается из па-
дающего меню Tools → Options… или из стандартного кон-
текстного меню при условии, что нет выполняющихся ко-
манд или выбранных объектов. Диалоговое окно Options со-
держит 10 вкладок, описанных ниже.



 
 
 

 
Определение доступа
к файлам поддержки

 
На вкладке Files диалогового окна Options, показанной на

рис. 3.1, задаются пути доступа к файлам поддержки, где
хранятся шрифты, шаблоны рисунков, типы линий и образ-
цы штриховок, используемые AutoCAD. Здесь перечисляют-
ся все пути доступа к папкам, которые должны существовать
в текущей структуре папок локального и подключенных се-
тевых дисков.



 
 
 

Рис. 3.1. Диалоговое окно определения доступа к файлам
поддержки

• В области Search paths, file names, and file locations: со-
держатся тематические заголовки путей доступа к файлам и



 
 
 

папкам поддержки:
• Support File Search Path – путь доступа к вспомогатель-

ным файлам;
• Working Support File Search Path – путь поиска рабочих

вспомогательных файлов;
• Device Driver File Search Path – путь доступа к драйверам

устройств;
• Project Files Search Path – путь доступа к файлам проек-

тов;
• Customization Files – файлы настройки;
• Help and Miscellaneous File Names – имена файлов спра-

вочной системы и др.;
• Text Editor, Dictionary, and Font File Names – имена фай-

лов текстового редактора, словаря и шрифтов;
• Print File, Spooler, and Prolog Section Names – имена фай-

ла печати, программы фоновой печати и раздела пролога;
• Printer Support File Path – путь к вспомогательным фай-

лам печати;
• Automatic Save File Location – папка для файла автосо-

хранения;
• Color Book Locations – папки для альбомов цветов;
• Data Sources Location – положение источников данных;
• Template Settings – параметры шаблонов;
• Tool Palettes File Locations – папки с файлами инстру-

ментальных палитр;
• Authoring Palette File Locations – папки файлов палитры



 
 
 

вариаций;
• Log File Location – расположение файла журнала;
• Plot and Publish Log File Location – папка для файла жур-

нала печати/публикации;
• Temporary Drawing File Location – папка для временных

файлов;
• Temporary External Reference File Location – папка для

временных файлов внешних ссылок;
• Texture Maps Search Path – папка для поиска текстур;
• Web File Search Path – папка для поиска веб-файлов;
• i-drop Associated File Location – папка для связанных

файлов точек загрузки.



 
 
 

 
Настройка параметров

рабочего экрана
 

На вкладке Display диалогового окна Options, показанной
на рис. 3.2, можно осуществлять настройку параметров ра-
бочего экрана AutoCAD.

Рис. 3.2. Диалоговое окно настройки параметров рабоче-
го экрана



 
 
 

• В области элементов окна Window Elements настраива-
ются следующие параметры:

– Color Scheme: – установка тона фоновой области ин-
струментов;

– Display scroll bars in drawing window – включаются/от-
ключаются полосы прокрутки;

– Display Drawing status bar – включаются/отключаются
инструменты строки состояния;

– Display screen menu – включается/отключается экранное
меню;

– Use large buttons for Toolbars – изменяется размер пик-
тограмм инструментов с 16 × 15 на 24 × 22 пиксела;

– Show ToolTips – включаются/отключаются всплываю-
щие подсказки около пиктограмм инструментов;

– Show shortcut keys in ToolTips – включаются/отключают-
ся комбинации клавиш в подсказках;

– кнопка Colors… – загружается диалоговое окно Drawing
Window Colors, для изменения цвета элементов рабочего
стола AutoCAD (рис. 3.3):



 
 
 

Рис. 3.3. Диалоговое окно изменения цвета элементов ра-
бочего стола AutoCAD

· список Context: – выбор объекта, в контексте ко-
торого будет изменен цвет элемента: 2D model space –
пространство двумерной модели, Sheet/layout – лист, 3D
parallel projection – трехмерная параллельная проекция, 3D
perspective projection – трехмерная перспективная проекция,



 
 
 

Block editor – редактор блоков, Command line – командная
строка, Plot preview – просмотр печати;

· список Interface element: – выбор элемента интерфей-
са, цвет которого необходимо установить. Для простран-
ства двумерной модели и листа – однородный фон, перекре-
стье, вектор автоотслеживания, маркер автопривязки, под-
сказка при прочерчивании, фон подсказки, источники све-
та, яркое пятно, спад освещенности, начальный предел, ко-
нечный предел, цвет обозначений камер, усеченная каме-
ра/плоскость усечения, плоскости подрезки камер. Для трех-
мерной параллельной проекции – однородный фон, перекре-
стье, основные линии сетки, промежуточные линии сетки,
осевые линии сетки и далее, аналогично пространству дву-
мерной модели. Для трехмерной перспективной проекции –
верх небесного фона, фоновый небесный горизонт, фоновое
наземное начало, фоновый наземный горизонт, низ земного
фона, фоновый земной горизонт и далее, аналогично трех-
мерной параллельной проекции. Для редактора блоков – од-
нородный фон, перекрестье, вектор автоотслеживания, мар-
кер автопривязки, подсказка при прочерчивании, фон под-
сказки, источники света, яркое пятно, спад освещенности,
начальный предел, конечный предел. Для командной строки
– однородный фон и текст. Для просмотра печати – однород-
ный фон;

· список Color: – выбор оттенка из цветовой палитры;
· кнопка Restore current element – восстановление текуще-



 
 
 

го элемента;
· кнопка Restore current context – восстановление текущего

контекста;
· кнопка Restore all contexts – восстановление всех контек-

стов;
· в области Preview: показан образец с текущими установ-

ками цвета;
– кнопка Fonts… – загружается диалоговое окно

Command Line Window Font, для изменения шрифта текста
командной строки (рис. 3.4). В этом диалоговом окне уста-
навливаются: Font: – шрифт, Font Style: – начертание и Size:
– размер. В области Sample Command Line Font показывает-
ся образец шрифта командной строки.

Рис. 3.4. Диалоговое окно изменения шрифтов



 
 
 

• В области Layout elements назначаются следующие пара-
метры пространства листа:

– Display Layout and Model tabs – управляет отображением
вкладок Layout и Model;

– Display printable area – управляет отображением границ
печатаемой области;

– Display paper background – управляет отображением фо-
на;

– Display paper shadow – управляет отображением тени во-
круг границ;

– Show Page Setup Manager for new layouts – управляет вы-
водом Диспетчера параметров для новых листов;

– Create viewport in new layouts – назначает создание ви-
довых экранов на новых листах.

• В области экранного разрешения Display resolution опре-
деляются:

– Arc and circle smoothness – плавность отображения дуг
и окружностей;

– Segments in a polyline curve – количество сегментов в
дугах полилиний;

– Rendered object smoothness – плавность отображения то-
нированных объектов;

– Contour lines per surface – количество образующих в по-
верхностях.

• В области Display performance настраивается произво-



 
 
 

дительность отображения объектов:
– Pan and zoom with raster & OLE – управляет динамиче-

ским отображением в реальном времени растровых изобра-
жений. Текущее значение параметра хранится в системной
переменной RTDISPLAY;

– Highlight raster image frame only – управляет подсвет-
кой растровых изображений при их выборе. При установ-
ке флажка подсвечиваются только границы растра. Теку-
щее значение параметра хранится в системной переменной
IMAGEHLT;

– Apply solid fill – управляет закраской плоских фигур и
полилиний ненулевой ширины. При установке флажка пока-
зывается закраска. Текущее значение параметра хранится в
системной переменной FILLMODE;

– Show text boundary frame only – управляет отображением
текста на экране. При установке флажка отображаются толь-
ко границы текстов. Текущее значение параметра хранится
в системной переменной QTEXTMODE;

– Draw true silhouettes for solids and surfaces – настраива-
ет отображение контура трехмерного объекта. При установ-
ке флажка вычерчиваются кромки силуэтов тел и поверхно-
стей. Текущее значение параметра хранится в системной пе-
ременной DISPSILH.

• В области Crosshair size устанавливается размер пере-
крестья в процентах от размера экрана.

• В области Reference Edit fading intensity устанавливается



 
 
 

затенение при редактировании ссылок.



 
 
 

 
Настройка параметров

открытия и сохранения файлов
 

Вкладка открытия и сохранения файлов Open and Save
диалогового окна Options показана на рис. 3.5.

Рис. 3.5. Диалоговое окно настройки параметров откры-
тия и сохранения файлов



 
 
 

На ней осуществляется настройка следующих парамет-
ров.

• В области File Save – параметры сохранения файлов:
– в списке Save As: устанавливается сохранение файлов в

заданном формате;
– кнопка Thumbnail Preview Setings… загружает одно-

именное диалоговое окно (рис. 3.6), осуществляющее на-
стройку образцов для просмотра. Флажком Save a thumbnail
preview image назначается создание образца для просмот-
ра. Флажком Generate Sheet, Sheet View and Model View
Thumbnails – создание образцов листов и видов листа/моде-
ли. Расположенная ниже линейка регулирует Perfomance –
производительность и Accuracy – точность;



 
 
 



 
 
 

Рис. 3.6. Диалоговое окно настройки образцов для про-
смотра

– в поле Incremental save percentage определяется процент
для быстрых сохранений.

• В области File Safety Precautions определяются меры
предосторожности при сохранении:

– Automatic save – включение функции автоматического
сохранения файла;

– Minutes between saves – определение интервала между
сохранениями в минутах;

– Create backup copy with each save – обеспечение созда-
ния резервных копий;

– Full-time CRC validation – осуществление постоянной
проверки контрольной суммы;

– Maintain a log file – ведение файла журнала;
– File extension for temporary files – определение расшире-

ния для временных файлов;
– кнопка Security Options… – загрузка одноименного диа-

логового окна, предназначенного для определения парамет-
ров безопасности, в котором можно задать пароль для от-
крытия текущего чертежа или цифровую подпись;

– Display digital signature information – отображение ин-
формации о цифровой подписи.

• В области File Open определяется: Number of recently-
used files – количество последних файлов, указываемых в па-



 
 
 

дающем меню, и Display full path in title – назначаются пол-
ные пути в заголовках.

• В области External References (Xrefs) определяются сле-
дующие параметры внешних ссылок:

– в списке Demand load Xrefs: – управление подгруз-
кой файлов внешних ссылок. Выбирается одно из значений:
Disabled – запрещено, Enabled – разрешено или Enabled with
copy – разрешено с копированием;

– Retain changes to Xref layers – сохранение изменений
слоев ссылок;

– Allow other users to Refedit current drawing – разрешение
редактирования рисунка как ссылки.

• В области ObjectARX Applications определяются следу-
ющие параметры приложений:

– в списке подгрузки приложений Demand load
ObjectARX apps: устанавливается один из режимов: Disable
load on demand – отключение загрузки по запросу, Custom
object detect – обнаружение сторонних объектов, Command
invoke – вызов команды или Object detect and command
invoke – обнаружение объектов и вызов команды;

– в списке заместителей для сторонних объектов Proxy
images for custom objects: назначается один из режимов:
Do not show proxy graphics – не показывать элементы,
Show proxy graphics – показывать элементы или Show proxy
bounding box – показывать только рамку;

– Show Proxy Information dialog box: – назначается вывод



 
 
 

окна сведений о заместителях.



 
 
 

 
Определение параметров

вывода на печать
 

Параметры печати задаются на вкладке Plot and Publish
диалогового окна Options – рис. 3.7.

Рис. 3.7. Диалоговое окно определения параметров выво-
да на печать



 
 
 

• В области Default plot settings for new drawings настра-
иваются параметры печати для новых чертежей по умолча-
нию:

– Use as default output device – устройство вывода по умол-
чанию;

– Use last successful plot settings – последнее успешно ис-
пользованное устройство;

– кнопка Add or Configure Plotters… – добавление и на-
стройка плоттеров.

• В области Plot to file настраивается печать в файл, то есть
определяется расположение файлов чертежей по умолчанию
и задается папка, в которую должны записываться файлы
чертежей при печати в файл.

• В области Background processing options настраиваются
параметры фоновой обработки установкой режима поддерж-
ки фонового вывода: Plotting – печать, Publishing – публика-
ция.

• В области Plot and publish log file назначается ведение
журнала:

– Automatically save plot and publish – вести журнал авто-
матически;

– Save one continuous plot log – общий файл для всех опе-
раций;

– Save one log per plot – отдельный файл для каждой опе-
рации.

• В области Auto publish назначается автопубликация:



 
 
 

– Automatic DWF Publish – автоматическая публикация
DWF-формата;

– кнопка Automatic DWF Publish Settings… – загрузка
диалогового окна Auto Publish Options.

• В области общих параметров печати General plot options
определяются следующие параметры:

– Keep the layout paper size if possible – сохранение (если
возможно) размеров листа при смене устройства печати;

– Use the plot device paper size – использование размеров
листа из устройства при смене устройства печати;

– в списке System printer spool alert: устанавливается ре-
жим предупреждения о буферизации:

· Always alert (and log errors) – всегда (регистрировать все
ошибки);

· Alert first time only (and log errors) – в первый раз (реги-
стрировать все ошибки);

· Never alert (and log first error) – никогда (регистрировать
первую ошибку);

· Never alert (do not log errors) – никогда (не регистриро-
вать ошибки);

– в списке OLE plot quality: устанавливается качество пе-
чати OLE-объектов:

· Monochrome (e.g. spreadsheet) – монохромное (напри-
мер, таблица);

· Low graphics (e.g. color text !& pie charts) – простая гра-
фика (например, круговая диаграмма);



 
 
 

· High graphics (e.g. photograph) – сложная графика (на-
пример, фотография);

· Automatically select – автоматический выбор;
– Use OLE application when plotting OLE objects – назна-

чение печати OLE-объектов в OLE-приложениях;
– Hide system printers – запрещение показа системных

принтеров.
• В области Specify plot offset relative to определяется от-

счет смещения чертежа:
– Printable area – от области печати;
– Edge of paper – от края листа.
• Кнопка Plot Stamp Settings… загружает диалоговое окно

Plot Stamp, позволяющее настроить параметры штемпелей
чертежей (рис. 3.8):



 
 
 

Рис. 3.8. Диалоговое окно штемпеля чертежа

–  в области Plot stamp fields определяется информация
для штемпеля:

· Drawing name – имя чертежа;
· Layout name – имя вкладки;
· Date and Time – дата и время;
· Login name – пользователь;
· Device name – устройство;
· Paper size – формат листа;
· Plot scale – масштаб чертежа;



 
 
 

– в области Preview демонстрируется образец штемпеля;
– в области User defined fields определяется дополнитель-

ная информация. Кнопка Add/Edit загружает диалоговое ок-
но User Defined Fields, позволяющее внести добавления и
изменения;

– в области Plot stamp parameter file назначается файл па-
раметров штемпеля. Кнопки Load и Save As позволяют за-
грузить и сохранить файлы;

– кнопка Advanced загружает диалоговое окно Advanced
Options (рис. 3.9), позволяющее определить дополнительные
параметры:



 
 
 

Рис. 3.9. Диалоговое окно дополнительных параметров

· в области Location and offset задаются расположения и
отступы: Location: – расположение (внизу слева, вверху сле-
ва, вверху справа или внизу справа); Orientation: – ориента-
ция (вертикально или горизонтально); Stamp upside-down –
перевернутый штемпель; X offset – отступ по оси X; Y offset
– отступ по оси Y; Offset relative to printable area – отступ от-
носительно области печати; Offset relative to paper border –
отступ относительно границ листа;

· в области Text properties назначаются свойства текста.
Font: – шрифт; Height: – высота; Single line plot stamp – од-
нострочный штемпель;

· в области Plot stamp units определяются единицы для
штемпеля (дюймы, миллиметры или пикселы);

· в области Log file Location определяется расположение
файла журнала. Create a log file – вести журнал в файле;
кнопка Browse… загружает диалоговое окно обзора.

• Кнопка Plot Style Table Settings… загружает одноимен-
ное диалоговое окно, позволяющее настроить таблицы сти-
лей печати (рис. 3.10):



 
 
 

Рис. 3.10. Диалоговое окно параметров таблиц стилей пе-
чати

– в области Default plot style behavior for new drawing опре-



 
 
 

деляются стили печати по умолчанию для новых чертежей:
· Use color dependent plot styles – цветозависимые стили

печати;
· Use named plot styles – именованные стили печати;
– в области Current plot style table settings настраивается

текущая таблица стилей печати:
· в списке Default plot style table – таблица стилей печати

по умолчанию;
· в списке Default plot style for layer 0: – стиль печати по

умолчанию для слоя 0;
· в списке Default plot style for objects: – стиль печати по

умолчанию для объектов;
– кнопка Add or Edit Plot Style Tables… загружает таблицы

стилей печати.



 
 
 

 
Настройка системных параметров

 
Для настройки системных параметров AutoCAD исполь-

зуется вкладка System диалогового окна Options – рис. 3.11.

Рис. 3.11. Диалоговое окно настройки системных пара-
метров

• В области 3D Perfomance определяется произво-
дительность трехмерной графики. Кнопка Perfomance



 
 
 

Settings загружает диалоговое окно Adaptive Degradation and
Peromance Tuning (рис. 3.12), позволяющее оптимизировать
параметры:

Рис. 3.12. Диалоговое окно адаптивного ухудшения и оп-
тимизации параметров

– в области Adaptive degradation настраивается адаптив-
ное ухудшение трехмерной графики:

· Degrade when FPS is below: – ухудшать, если показатель
«кадры в секунду» меньше, чем указанное значение в поле;

· Degradation order: – настраивается порядок ухудшения.



 
 
 

Необходимо удалить отметку для элементов, которые не сле-
дует ухудшать (объекты, зависящие от вида; сглаживание ли-
ний; освещение; качество прозрачности; полные тени; про-
зрачность; не учитывать задние грани; тени на земле; сти-
ли ребер; ребра граней; быстрые силуэты; текстуры; матери-
алы; качество освещения; фон; ребра пересечения; отобра-
жение граней; отображение каркаса). Рекомендуется удалять
незначительное количество;

· Learn about adaptive degradation – ссылка на информацию
об адаптивном ухудшении;

– в области Hardware and performance tuning оптимизиру-
ются параметры оборудования и программного обеспечения
трехмерной графики. Управление текущей конфигурацией
аппаратного обеспечения выполняется Мастером оптимиза-
ции параметров;

· кнопка View Tune Log обеспечивает просмотр протокола
оптимизации;

· кнопка Manual Tune загружает диалоговое окно Manual
Perfomance Tuning (рис. 3.13), которое обеспечивает руч-
ную оптимизацию параметров: Enable hardware acceleration
– включает аппаратное ускорение; в  списке Driver name:
– указывается имя драйвера; ниже включаются и отклю-
чаются эффекты (ускорение для геометрии, отображение
сглаженных линий, модуль раскрашивания по Гучу, полное
отображение теней). Далее указываются общие параметры:
Discard back faces – не учитывать задние грани; Transparency



 
 
 

quality: – качество прозрачности (высокое, среднее, низкое).
В нижней части диалогового окна регулируется Dynamic
tessellation – динамическая аппроксимация: Surfaces: – при
визуализации поверхностей, Curves: – при визуализации
кривых; в  списке Number of tessellations to cache: указы-
вается количество уровне аппроксимации. Кнопка Reset to
Recommended Values дает возможность вернуться к реко-
мендованным значениям;



 
 
 



 
 
 

Рис. 3.13. Диалоговое окно ручной оптимизации пара-
метров

· кнопка Check for Updates осуществляет проверку обнов-
лений.

• В области Current Pointing Device выбирается текущее
устройство указания, а также источник входных данных:
Digitizer only – только дигитайзер, Digitizer and mouse – ди-
гитайзер и мышь.

• В области Layout Regen Options настраивается регенера-
ция вкладок:

– Regen when switching layouts – регенерация при пере-
ключении;

– Cache model tab and last layout – кэширование модели и
последнего листа;

– Cache model tab and all layouts – кэширование модели и
всех листов.

• В области dbConnect Options устанавливаются парамет-
ры подключения к базам данных:

– Store Links index in drawing file – хранить индекс связей
в рисунке;

– Open tables in read-only mode – открывать таблицы толь-
ко для чтения.

• В области General Options назначаются общие парамет-
ры:

– Display OLE Text Size Dialog – вывод диалогового окна



 
 
 

размера текста OLE-объектов;
– Beep on error in user input – оповещение об ошибках

пользовательского ввода при помощи звукового сигнала;
– Load acad.lsp with every drawing – загрузка файла

acad.lsp с каждым рисунком;
– Allow long symbol names – разрешение на использование

длинных имен.
• В области Live Enabler Options настраиваются параметры

адаптеров объектов:
– Check Wed for Live Enablers – организуется поиск адап-

теров в Интернете;
– Maximum number of unsuccessful checks – определяется

максимальное число отрицательных проверок.



 
 
 

 
Настройка пользовательской среды

 
На вкладке User Preferences диалогового окна Options

можно настроить пользовательскую среду рисования по сво-
ему усмотрению (рис. 3.14).

Рис. 3.14. Диалоговое окно настройки пользовательской
среды

• В области Windows Standard Behavior назначается соот-



 
 
 

ветствие стандартам Windows:
– Double click editing – редактирование по двойному на-

жатию;
– Shortcut menus in drawing area – отображение контекст-

ных меню в области рисования;
– кнопка Right-click Customizations… – загрузка одно-

именного диалогового окна, позволяющего выбрать дей-
ствия, к которым приводит щелчок правой кнопки мыши
(рис. 3.15):



 
 
 

Рис. 3.15. Диалоговое окно настройки правой кнопки мы-
ши

· Turn on time-sensitive right-click – учитывать длитель-



 
 
 

ность нажатия: Quick click for ENTER – кратковременное на-
жатие вызывает ENTER; Longer click to display Shortcut Menu
– долгое нажатие вызывает контекстное меню; Longer click
duration: – продолжительность нажатия;

· в области Default Mode настраивается обычный режим.
Если нет выбранных объектов, то правая кнопка вызывает:
Repeat Last Command – повтор последней команды, Shortcut
Menu – контекстное меню;

· в области Edit Mode настраивается режим редактиро-
вания. Если объекты выбраны, то правая кнопка вызывает:
Repeat Last Command – повтор последней команды, Shortcut
Menu – контекстное меню;

· в области Command Mode настраивается командный ре-
жим. Если выполняется команда, то правая кнопка вызыва-
ет: ENTER, Shortcut Menu: always enabled – всегда доступное
контекстное меню, Shortcut Menu: enabled when command
options are present – контекстное меню, доступное, если ко-
манда имеет ключи.

• В области Insertion scale определяется масштаб вставки.
Если не заданы единицы вставки, то использовать:

– Source content units: – единицы исходного чертежа (дюй-
мы, футы, мили, миллиметры, сантиметры, метры, километ-
ры, микродюймы, милы, ярды, ангстремы, нанометры, мик-
роны, дециметры, декаметры, гектометры, гигаметры, астро-
номические единицы, световые годы, парсеки);

– Target drawing units: – единицы целевого чертежа (дюй-



 
 
 

мы, футы, мили, миллиметры, сантиметры, метры, километ-
ры, микродюймы, милы, ярды, ангстремы, нанометры, мик-
роны, дециметры, декаметры, гектометры, гигаметры, астро-
номические единицы, световые годы, парсеки).

• В области Fields определяются поля:
– флажок Display background of fields назначает отображе-

ние заднего плана;
– кнопка Field Update Settings… загружает одноименное

диалоговое окно, позволяющее настроить условия автомати-
ческого обновления полей (рис. 3.16):

Рис. 3.16. Диалоговое окно настройки обновления полей

· Open – открытие;
· Save – сохранение;
· Plot – печать;



 
 
 

· eTransmit – формирование комплекта;
· Regen – регенерация.
• В области Priority for Coordinate Data Entry определяют-

ся способы ввода координат:
– Running object snap – согласно привязке;
– Keyboard entry – с клавиатуры;
– Keyboard entry except scripts – с клавиатуры (кроме па-

кетов).
• В области Associative Dimensioning назначается ассоци-

ативность новых размеров.
• В области гиперссылок Hyperlink назначаются курсор,

подсказки и контекстное меню.
• В области Undo/Redo определяется, объединять ли ко-

манды зумирования и панорамирования.
• Кнопка Lineweight Settings… загружает одноименное

диалоговое окно, позволяющие определить параметры весов
линий (рис. 3.17):



 
 
 

Рис. 3.17. Диалоговое окно настройки параметров весов
линий

– Lineweights – веса линий;
– Units for Listing – единицы в списке: Millimeters (mm) –

миллиметры, Inches (in) – дюймы;
– Display Lineweight – отображать линии в соответствии

с весами. В раскрывающемся списке Default – указывается
значение веса линии по умолчанию;

– Adjust Display Scale – масштаб экранного отображения.
• Кнопка Edit Scale List… загружает одноименное диало-

говое окно, позволяющее изменить список масштабов (рис.
3.18).



 
 
 

Рис. 3.18. Диалоговое окно изменения списка масштабов



 
 
 

 
Управление точностью
построения объектов

 
На вкладке построений Drafting диалогового окна

Options, показанной на рис. 3.19, можно сделать следующие
назначения.

Рис. 3.19. Диалоговое окно управления точностью по-
строения объектов



 
 
 

• В области AutoSnap Settings назначаются следующие па-
раметры автопривязки:

– Marker – маркер;
– Magnet – магнит;
– Display AutoSnap tooltip – всплывающие подсказки ав-

топривязки;
– Display AutoSnap aperture box – прицел автопривязки;
– кнопка Colors… загружает диалоговое окно Drawing

Window Colors (см. рис. 3.3), позволяющее изменить цвет
маркера автопривязки.

• В области AutoSnap Marker Size определяется размер
маркера автопривязки.

• В области Object Snap Options определяются параметры
объектной привязки:

– Ignore hatch objects – игнорировать штриховку;
– Replace Z value with current elevation – заменить корди-

нату Z на текущее значение оценки;
– Ignore negative Z object snaps for Dynamic UCS – игно-

рировать для динамической ПСК объектные привязки с от-
рицательной координатой Z.

• В области AutoTrack Settings назначаются следующие
параметры автоотслеживания:

– Display polar tracking vector – бесконечные линии поляр-
ного отслеживания;

– Display full-screen tracking vector – бесконечные линии



 
 
 

объектного отслеживания;
– Display AutoTrack tooltip – всплывающие подсказки ав-

тоотслеживания.
• В области Alignment Point Acquisition задаются режимы

захвата точек отслеживания:
– Automatic – автоматический;
– Shift to acquire – с нажатием клавиши Shift.
• В области Aperture Size определяется размер прицела.
• Кнопка Drafting Tooltip Settings… загружает диалоговое

окно Tooltip Appearance (рис. 3.20), определяющее внешний
вид подсказок:



 
 
 

Рис. 3.20. Диалоговое окно настройки внешнего вида
подсказок

– Model Preview – предварительный просмотр внешнего
вида подсказок в пространстве модели;

– Layout Preview – предварительный просмотр внешнего



 
 
 

вида подсказок в пространстве листа;
– кнопка Colors… – загружает диалоговое окно Drawing

Window Colors (см. рис. 3.3), позволяющее изменить цвет
подсказок;

– Size – изменение размера подсказок;
– Transparency – изменение прозрачности подсказок;
– Override OS settings for all drafting tooltips – замена па-

раметров ОС для всех подсказок на чертеже;
– Use settings only for Dynamic Input tooltips – замена па-

раметров только для подсказок динамического ввода.
• Кнопка Lights Glyph Settings… загружает диалоговое ок-

но Light Glyph Appearance (рис. 3.21), определяющее вид
обозначений источников света:



 
 
 

Рис. 3.21. Диалоговое окно настройки обозначений ис-
точников света

–  Glyph Preview – предварительный просмотр образцов
обозначений источников света: Point – точечный источник,
Spot – прожектор;



 
 
 

– кнопка Edit Glyph Colors загружает диалоговое окно
Drawing Window Colors (см. рис. 3.3), позволяющее редак-
тировать цветовую гамму обозначений источников света;

– Glyph Size: – установка размера обозначений источни-
ков света.

• Кнопка Cameras Glyph Settings… загружает диалоговое
окно Camera Glyph Appearance (рис. 3.22), определяющее
вид обозначения камеры:



 
 
 

Рис. 3.22. Диалоговое окно настройки обозначений камер

– кнопка Edit Glyph Colors… загружает диалоговое окно



 
 
 

Drawing Window Colors (см. рис. 3.3), позволяющее редак-
тировать цветовую гамму обозначения камеры;

– Glyph Size: – установка размера обозначений камеры.



 
 
 

 
Настройка параметров

трехмерного моделирования
 

Вкладка настройки параметров трехмерного моделирова-
ния 3D Modeling диалогового окна Options, показанная на
рис. 3.23, позволяет сделать следующие назначения.

Рис. 3.23. Диалоговое окно настройки параметров трех-
мерного моделирования



 
 
 

• В области 3D Crosshairs определяются параметры трех-
мерного перекрестья:

– Show Z axis in crosshairs – показывать ось Z в перекре-
стьях;

– Label axes in standard crosshairs – метки осей в стандарт-
ных перекрестьях;

– Show labels for dynamic UCS – показывать метки дина-
мической ПСК;

– Crosshair labels – установка параметров меток на пере-
крестьях: Use X, Y, Z – использовать X, Y, Z; Use N, E, z –
использовать N, E, z; Use custom labels – использовать поль-
зовательские метки.

• В области Display ViewCube or UCS Icon определяются
параметры показа значка ПСК:

– Display UCS Icon in 2D model space – показывать значок
ПСК в двумерном пространстве модели;

– Display in 3D model space – показывать значок ПСК в
трехмерном пространстве модели.

• В области Display Input определяется параметр динами-
ческого ввода:

– Show Z field for pointer input – показывать поле для ввода
Z.

• В области 3D Objects определяются параметры трехмер-
ных объектов:

– в списке Visual Style while creating 3D objects устанав-



 
 
 

ливается визуальный стиль при создании трехмерных объ-
ектов: ByViewport – по видовому экрану, 2D Wireframe –
двумерный каркас, 3D Hidden – трехмерный скрытый, 3D
Wireframe – трехмерный каркас, Conceptual – концептуаль-
ный, Realistic – реалистичный;

– в списке Deletion control while creating 3D objects опре-
деляется управление удалением при создании трехмерных
объектов:

· Retain defining geometry – сохранять определяющие объ-
екты;

· Delete profile curves – удалить кривые профиля;
· Delete profile and path curves – удалить профиль и кри-

волинейные траектории;
· Prompt to delete profile curves – запрос удаления профиля

и криволинейных траекторий;
· Prompt to delete profile and path curves – запрос удаления

кривых профиля;
– U isolines on surfaces and meshes – установка значения

U-изолинии на поверхностях и сетях;
– V isolines on surfaces and meshes – установка значения V-

изолинии на поверхностях и сетях.
• В области 3D Navigation определяются параметры нави-

гации:
– Reverse mouse wheel zoom – установка реверса зумиро-

вания колесиком мыши;
– кнопка Walk and Fly… – загрузка диалогового окна Walk



 
 
 

and Fly Settings (рис. 3.24), позволяющего установить пара-
метры обхода и облета:

Рис. 3.24. Диалоговое окно установки параметров обхода
и облета

· в области Settings – вариант показа окна команд: When
entering walk and fly modes – при переходе в режимы обхода



 
 
 

и облета, Once per session – раз за сеанс, Never – не показы-
вать. А также Display Position Locator window – показывать
диалоговое окно локатора положения;

· в области Current drawing settigs определяются парамет-
ры текущего чертежа: Walk/fly step size: – величина шага об-
хода/облета в единицах чертежа, Steps per second: – количе-
ство шагов в секунду;

– кнопка Animation… – загрузка диалогового окна
Animation Settings (рис. 3.25), позволяющего установить па-
раметры анимации:



 
 
 

Рис. 3.25. Диалоговое окно установки параметров анима-
ции

· в области Settings – режимы: Visual style: – визуальный
стиль (обычный, тонирование; трехмерный скрытый, трех-
мерный каркас, концептуальный, реалистичный; черновой,
низкий, средний, высокий, презентационный), Resolution: –
разрешение, Frame rate (FPS): – частота кадров в секунду,
Format: – формат.



 
 
 

 
Настройка параметров

выбора объектов
 

Вкладка настройки параметров выбора объектов Selection
диалогового окна Options, показанная на рис. 3.26, позволя-
ет сделать следующие назначения.

Рис. 3.26. Диалоговое окно настройки параметров выбора
объектов



 
 
 

• В области Pickbox Size определяется размер прицела.
• В области Selection Preview определяются параметры

просмотра выбранных объектов:
– When a command is active – когда активна команда;
– When no command is active – если нет активных команд;
– кнопка Visual Effect Settings… загружает одноименное

диалоговое окно (рис. 3.27), позволяющее определить пара-
метры визуальных эффектов:

Рис. 3.27. Диалоговое окно настройки параметров визу-
альных эффектов

· в области Selection Preview Effect – задать эффект про-
смотра выбранных объектов: Dash – пунктиром, Thicken
– с приданием толщины, Both – оба варианта. Кноп-
ка Advanced Options загружает диалоговое окно Advanced
Preview Options (рис. 3.28), позволяющее настроить допол-
нительные параметры и настроить фильтр просмотра вы-



 
 
 

бранных объектов: Exclude objects on locked layers – ис-
ключить объекты на заблокированных слоях. Исключить:
Xrefs – внешние ссылки, Tables – таблицы, Groups – группы,
Multiline text – многострочный текст, Hatches – штриховки;

Рис. 3.28. Диалоговое окно настройки дополнительных
параметров просмотра выбранных объектов

· в области Area Selection Effect – задать эффект выбран-
ной области: Indicate selection area – указать область, Window
selection color: – цвет рамки выбора, Crossing selection color: –
цвет зачеркивания выбранной области, Selection area opacity:



 
 
 

– степень затенения выбранной области.
• В области Selection Modes определяются режимы выбо-

ра:
– Noun/verb selection – предварительный выбор;
– Use Shift to add to selection – использование клавиши

Shift для добавления;
– Press and drag – динамическая рамка;
– Implied windowing – выбор с помощью рамки;
– Object grouping – группа объектов;
– Associative Hatch – ассоциативная штриховка.
• В области Grip Size определяется размер ручек.
• В области Grips определяются параметры ручек:
– Unselected grip color: – цвет невыбранных ручек;
– Selected grip color: – цвет выбранных ручек;
– Hover grip color: – цвет ручки под курсором;
– Enable grips – включить ручки;
– Enable grips within blocks – ручки внутри блоков;
– Enable grip tips – подсказки к ручкам;
– Object selection limit for display of grips – предельное ко-

личество выбранных объектов для показа ручек.



 
 
 

 
Настройка профилей

 
Вкладка Profiles диалогового окна Options использует-

ся для создания профилей и сохранения в них параметров
среды рисования (рис. 3.29). Профиль – набор параметров
настройки AutoCAD, сохраненный с уникальным именем.
Один из профилей является текущим; он определяет на-
стройки рабочей среды рисования. Пользователи, входящие
в систему под одним именем, могут загружать свои настрой-
ки из различных профилей. По умолчанию AutoCAD запи-
сывает текущие параметры в профиль без имени Unnamed
Profile. Имена текущего профиля и рисунка всегда выводят-
ся над названиями вкладок диалогового окна Options.



 
 
 

Рис. 3.29. Диалоговое окно настройки профилей

На вкладке Profiles можно осуществлять следующие на-
стройки:

• в области имеющихся профилей Available Profiles: – вы-
бирать необходимый из перечня доступных;

• нажатием кнопки Set Current – устанавливать выбран-
ный профиль в качестве текущего;

• используя кнопку Add to List… – добавлять новый про-
филь;

• с помощью кнопки Renane… – переименовывать имею-
щиеся профили;



 
 
 

• с помощью кнопки Delete – удалять имеющиеся профи-
ли;

• с помощью кнопки Export… – экспортировать настрой-
ки текущего профиля во внешний ARG-файл;

• после щелчка на кнопке Import… – импортировать на-
стройки профиля из внешнего ARG-файла;

• кнопкой Reset – сбрасывать настройки.



 
 
 

 
Глава 4

Системы координат
 

Ввод координат
Динамический ввод координат
Декартовы и полярные координаты
Формирование точек методом «направление – рас-

стояние»
Определение трехмерных координат
Правило правой руки
Ввод трехмерных декартовых координат
Ввод цилиндрических координат
Ввод сферических координат
Координатные фильтры
Определение пользовательской системы коорди-

нат
Выбор пользовательской системы координат в про-

странстве
Работа с ПСК на видовых экранах
Выбор стандартной пользовательской системы ко-

ординат



 
 
 

 
Ввод координат

 
Когда программа AutoCAD запрашивает точку, коман-

да ожидает ввода координат какой-либо точки текущего ри-
сунка. В AutoCAD может быть включен контроль лими-
тов рисунка, осуществляемый командой LIMITS. В этом
случае, если введенная точка выходит за пределы рисунка,
AutoCAD выдает сообщение:

** Outside limits – вне лимитов

и отвергает введенную точку.
В представлении рисунка во внутренней графической ба-

зе данных координаты каждой точки задаются с точностью
не менее 14 значащих цифр.

Ввод координат в AutoCAD может осуществляться двумя
способами:

• непосредственно с клавиатуры, путем указания числен-
ных значений;

• с использованием графического маркера (курсора), ко-
торый движется по экрану с помощью устройства указа-
ния. Ввод координат осуществляется щелчком левой кноп-
кой мыши.

Как следствие, в строке состояния, расположенной внизу
рабочего стола, происходит отображение текущих значений
координат. Существует три режима отображения координат:



 
 
 

• динамический, при котором обновление координат про-
исходит постоянно по мере перемещения указателя мыши;

• статический, при котором координаты обновляются
только после указания точки;

• режим относительных координат, формат расстояни-
е<угол, при котором обновление значений происходит по ме-
ре перемещения указателя мыши во время рисования объ-
екта, содержащего более одной точки.

Включение отображения координат в строке состоя-
ния осуществляется с помощью системной переменной
COORDS. Значение 0 соответствует статическому отобра-
жению, 1 – динамическому, 2 – относительному.

Для определения координат точек существующих объек-
тов (например, точки пересечения или середины отрезка)
можно воспользоваться командой ID. При этом следует при-
менять объектную привязку, иначе полученные координаты
могут оказаться неточными.

Для определения координат сразу всех характерных точек
объекта удобно использовать команду LIST. Еще один метод
получения координат характерных точек – выбор объекта с
помощью ручек. Ручки представляют собой маленькие пря-
моугольники, располагающиеся в характерных точках объ-
ектов, например конечных точках и середине отрезка. При
привязке курсора к одной из ручек в поле координат строки
состояния отображаются ее координаты.

Для удобства ввода координат можно использовать:



 
 
 

• ортогональный режим, когда изменение координат про-
исходит только по оси X или Y. Ортогональный режим вклю-
чается либо нажатием функциональной клавиши F8, либо
щелчком на кнопке

Ortho Mode в строке состояния;
• привязку к узлам невидимой сетки, определенной с

некоторым шагом по осям X и Y. Такую шаговую привязку
можно установить либо нажав функциональную клавишу F9,
либо щелкнув на кнопке

Snap Mode в строке состояния. Если включен шаг привяз-
ки, то при перемещении мыши перекрестье будет «перепры-
гивать» с одного узла невидимой сетки на другой.

Значения координат независимо от способа ввода всегда
связаны с некоторой системой координат. По умолчанию в
AutoCAD используется так называемая мировая система ко-
ординат, МСК – World Coordinate System (WCS). Она опре-
делена так, что ось OX направлена слева направо, ось OY
– снизу вверх, ось OZ – перпендикулярно экрану, вовне.
Как правило, для выполнения конкретного проекта удобнее
определить пользовательскую систему координат, ПСК –
User Coordinate System (UCS), которую можно сместить от-
носительно мировой и/или повернуть под любым углом. До-



 
 
 

пускается существование нескольких пользовательских си-
стем координат, и в любой момент возможен переход от од-
ной к другой.

Никакие изменения МСК не допускаются. AutoCAD поз-
воляет одновременно использовать и координаты, связанные
с текущей ПСК, и координаты, связанные с МСК. При этом
для МСК при вводе с клавиатуры значению координат дол-
жен предшествовать символ «звездочка» (*).



 
 
 

 
Динамический ввод координат

 
С помощью функции динамического ввода значения ко-

ординат можно вводить не в командной строке, а в поле
всплывающей подсказки, которая отображается рядом с кур-
сором и динамически обновляется по мере перемещения
курсора. Функция динамического ввода включается и от-
ключается в строке состояния кнопкой

Dynamic Input.
Существует два типа динамического ввода:
• ввод значений координат с помощью мыши;
• ввод размеров для линейных и угловых значений.
Настройка динамического ввода осуществляется в диа-

логовом окне режимов рисования Drafting Settings, вкладка
Dynamic Input (рис. 4.1), которое вызывается из падающего
меню Tools → Drafting Settings… или из контекстного меню
щелчком правой кнопки мыши в строке состояния на кноп-
ке Dynamic Input и выбором пункта Settings….



 
 
 

Рис. 4.1. Диалоговое окно настройки динамического вво-
да

Здесь настраиваются следующие параметры динамиче-
ского ввода.

• Enable Pointer Input – включить ввод с помощью мыши.
• Enable Dimension Input where possible – включить ввод

размеров, где возможно.



 
 
 

• В области Pointer Input кнопкой Settings… загружается
диалоговое окно Pointer Input Settings (рис. 4.2), позволяю-
щее настроить параметры ввода с помощью мыши:



 
 
 



 
 
 

Рис. 4.2. Диалоговое окно настройки параметров ввода с
помощью мыши

– в области Format – назначить использование по умолча-
нию для второй или следующих точек:

· Polar format – полярный формат;
· Cartesian format – декартов формат;
· Relative coordinates – относительные координаты;
· Absolute coordinates – абсолютные координаты;
– в области Visibility – показывать подсказки для коорди-

нат:
· As soon as I type coordinate data – одновременно с вводом

координатных данных;
· When a command asks for a point – когда команда содер-

жит запрос для точки;
· Always – even when not in command – всегда, даже если

не в команде.
• В области Dimension Input кнопкой Settings… загружа-

ется диалоговое окно настройки параметров ввода размеров
Dimension Input Settings (рис. 4.3), позволяющее установить
видимость при растяжке ручек:



 
 
 

Рис. 4.3. Диалоговое окно настройки параметров ввода
размеров

– Show only 1 dimension input field at a time – показывать
одновременно только одно поле для ввода размеров;

– Show 2 dimension input fields at a time – показывать од-
новременно два поля для ввода размеров;



 
 
 

– Show the following dimension input fields simultaneously:
– показывать одновременно следующие поля для ввода раз-
меров:

· Resulting Dimension – результирующий размер;
· Length Change – изменение длины;
· Absolute Angle – абсолютный угол;
· Angle Change – изменение угла;
· Arc Radius – радиус дуги.
• В области Dynamic Prompts – настроить динамические

подсказки:
– Show command prompting and command input near the

crosshairs – показывать подсказку для ввода команды и вво-
димую команду рядом с перекрестьем;

– в динамической подсказке для доступа к параметрам
необходимо нажать клавишу ↓ (стрелка вниз).

• Кнопка Drafting Tooltip Appearance… загружает диало-
говое окно Tooltip Appearance (рис. 4.4), позволяющее на-
строить внешний вид подсказок на чертеже:



 
 
 

Рис. 4.4. Диалоговое окно настройки внешнего вида под-
сказок на чертеже

– Model Preview – предварительный просмотр модели;



 
 
 

– Layout Preview – предварительный просмотр листа;
– Colors… – выбор цвета в диалоговом окне Drawing

Window Colors (см. рис. 3.3);
– Size – установка размера;
– Transparency – установка прозрачности;
– Override OS settings for all drafting tooltips – заменить

параметры ОС для всех подсказок на чертеже;
– Use settings only for Dynamic Input tooltips – заменить

параметры только для подсказок динамического ввода;
– кнопка Options… загружает одноименное диалоговое

окно, вкладку Drafting (см. рис. 3.19).
При использовании ввода с помощью мыши в области ри-

сования при перемещении курсора будут отображаться зна-
чения координат, для ввода которых необходимо сначала
ввести значение, затем для перехода к следующей подсказке
нажать клавишу TAB и после этого ввести значение следую-
щей координаты. При определении точки первая координата
является абсолютной, Формат второй и следующих точек –
относительные полярные координаты. Если требуется ввести
абсолютное значение, необходимо перед ним ввести знак #.



 
 
 

 
Декартовы и полярные координаты

 
В двумерном пространстве точка определяется в плоско-

сти XY, которая называется также плоскостью построений.
Ввод координат с клавиатуры возможен в виде абсолютных
и относительных координат.

Ввод абсолютных координат производится в следующих
форматах:

• декартовы (прямоугольные) координаты. При этом для
определения двумерных и трехмерных координат применя-
ются три взаимно перпендикулярные оси: X, Y и Z. Для вво-
да координат указывается расстояние от точки до начала ко-
ординат по каждой из этих осей, а также направление (+ или
-). При начале нового рисунка текущей системой всегда яв-
ляется мировая система координат World Coordinate System
(WCS), следовательно, ось X направлена горизонтально, ось
Y – вертикально, а ось Z перпендикулярна плоскости XY;

• полярные координаты. При вводе координат указывается
расстояние, на котором располагается точка от начала коор-
динат, а также величина угла, образованного полярной осью
и отрезком, мысленно проведенным через данную точку и
начало координат. Угол задается в градусах против часовой
стрелки. Значение 0 соответствует положительному направ-
лению оси OX.

Относительные координаты задают смещение от послед-



 
 
 

ней введенной точки. При вводе точек в относительных ко-
ординатах можно использовать любой формат записи в аб-
солютных координатах: @dx,dy – для декартовых, @r<A –
для полярных.

Относительные декартовы координаты удобно применять
в том случае, если известно смещение точки относительно
предыдущей.

 
Пример. Построение в

абсолютных координатах
 

Постройте многоугольник, задавая точки в абсолютных
координатах (рис. 4.5).

Рис. 4.5. Построение многоугольника



 
 
 

Запустите команду формирования отрезка LINE, вызвав
ее из падающего меню Draw → Line или щелкнув на пикто-
грамме Line на панели инструментов Draw. Ответьте на за-
просы:

_LINE
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: 190,20 – точка 2
Specify next point or [Undo]: 190,100 – точка 3
Specify next point or [Close/Undo]: 130,40 – точка 4
Specify next point or [Close/Undo]: 130,100 – точка 5
Specify next point or [Close/Undo]: Close – замкните

линию

 
Пример. Построение в

относительных координатах
 

Постройте многоугольник, показанный на рис. 4.5, зада-
вая точки в относительных координатах.

Запустите команду формирования отрезка LINE, вызвав
ее из падающего меню Draw → Line или щелкнув на пикто-
грамме Line на панели инструментов Draw. Ответьте на сле-
дующие запросы (символ @ вводится при одновременном
нажатии клавиш Shift+2):



 
 
 

_LINE
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: @150,0 – в точку 2

относительно точки 1
Specify next point or [Undo]: @0,80 – в точку 3

относительно точки 2
Specify next point or [Close/Undo]: @-60,-60 – в точку

4 относительно точки 3
Specify next point or [Close/Undo]: @0,60 – в точку 5

относительно точки 4
Specify next point or [Close/Undo]: Close – замкните

линию

 
Пример. Построение в
полярных координатах

 
Постройте многоугольник, задавая точки в полярных ко-

ординатах (см. рис. 4.5).

Запустите команду формирования отрезка LINE, вызвав
ее из падающего меню Draw → Line или щелкнув на пикто-
грамме Line на панели инструментов Draw. Ответьте на за-
просы:

_LINE



 
 
 

Specify first point: 40,20 – точка 1
Specify next point or [Undo]: @150<0 – в точку 2

относительно точ ки 1
Specify next point or [Undo]: @80<90 – в точку 3

относительно точки 2
Specify next point or [Close/Undo]: @85<-135 – в

точку 4 относительно точки 3
Specify next point or [Close/Undo]: @60<90 – в точку

5 относительно точки 4
Specify next point or [Close/Undo]: Close – замкните

линию



 
 
 

 
Формирование точек методом
«направление – расстояние»

 
Вместо ввода координат допускается использование пря-

мой записи расстояния , что особенно удобно для быстро-
го ввода длины линии. Такой ввод может производиться во
всех командах, кроме тех, которые предполагают указание
просто действительного значения, например в командах по-
строения массива ARRAY, разметки MEASURE и деления
объекта DIVIDE. При использовании прямой записи рассто-
яния в ответ на запрос точки достаточно переместить мышь
в нужном направлении и ввести числовое значение в команд-
ной строке. Например, если таким способом задается отре-
зок, то он строится путем указания числового значения дли-
ны и направления под определенным углом. При включен-
ном ортогональном режиме этим способом очень удобно ри-
совать перпендикулярные отрезки.



 
 
 

 
Определение трехмерных координат

 
Трехмерные координаты задаются аналогично двумер-

ным, но к двум составляющим по осям X и Y добавляется
третья величина – по оси Z. В трехмерном пространстве ана-
логично двумерному моделированию можно использовать
абсолютные и относительные координаты, а также цилиндри-
ческие и сферические, которые схожи с полярными в двумер-
ном пространстве.

Значения координат независимо от способа ввода всегда
связаны с некоторой системой координат. При работе в трех-
мерном пространстве значения x, y и z указывают либо в ми-
ровой системе координат World Coordinate System (WCS),
либо в пользовательской User Coordinate System (UCS).



 
 
 

 
Правило правой руки

 
При работе в трехмерном пространстве в AutoCAD все

системы координат формируются по правилу правой руки.
Оно определяет положительное направление оси Z трехмер-
ной системы координат при известных направлениях осей X
и Y, а также положительное направление вращения вокруг
любой из осей трехмерных координат.

Для определения положительных направлений осей необ-
ходимо поднести тыльную сторону кисти правой руки к
экрану монитора и направить большой палец параллельно
оси X, а указательный – по оси Y. Если согнуть средний па-
лец перпендикулярно ладони, как показано на рис. 4.6 спра-
ва, то он будет указывать положительное направление оси Z.



 
 
 

Рис. 4.6. Правило правой руки

Для определения положительного направления вращения
следует сориентировать большой палец правой руки в по-
ложительном направлении оси и согнуть остальные пальцы,
как показано на рис. 4.6 слева. Положительное направление
вращения совпадает с направлением, указываемым согнуты-
ми пальцами.



 
 
 

 
Ввод трехмерных

декартовых координат
 

Трехмерные декартовы координаты (x, y, z) вводятся ана-
логично двумерным (x, y). Дополнительно к координатам по
осям X и Y необходимо ввести еще и значение по оси Z. На
самом деле в AutoCAD не существует двумерных координат,
и если введены значения только x и y, это означает, что от-
сутствующая координата z берется по умолчанию равной ну-
лю (системная переменная THICKNESS). При указании де-
картовых трехмерных координат с клавиатуры вводятся три
числа через запятую, например:

3,5,2

В трехмерном пространстве, так же как и в двумерном,
широко используются и абсолютные координаты (отсчиты-
ваемые от начала координат), и относительные (отсчитывае-
мые от последней указанной точки). Признак относительных
координат – символ @ перед координатами вводимой точки,
которая в этом случае берется относительно последней вве-
денной точки.



 
 
 

 
Ввод цилиндрических координат

 
Ввод цилиндрических координат аналогичен указанию

полярных координат на плоскости. Дополнительно появля-
ется значение, определяющее координату z по оси Z, пер-
пендикулярной плоскости XY. Цилиндрические координаты
описывают расстояние от начала системы координат (или от
предыдущей точки в случае с относительными координата-
ми) до точки на плоскости XY, угол относительно оси X и
расстояние от точки до плоскости XY. Угол задается в гра-
дусах.

На рис. 4.7 показана точка с координатами 7<30,5. Эта
точка лежит на расстоянии 7 единиц от начала системы ко-
ординат в плоскости XY, под углом 30° к оси X на плоско-
сти XY и имеет координату Z, равную 5. Относительные ци-
линдрические координаты строятся так же, как и абсолют-
ные, просто воображаемое начало координат переносится в
последнюю введенную точку.



 
 
 

Рис. 4.7. Указание цилиндрических координат
 

Пример. Построение в
цилиндрических координатах

 
Цилиндрические координаты применяются при вводе то-

чек трехмерного пространства реже, чем декартовы. Их ис-
пользование бывает необходимо, например, для построения
спиральных объектов. В следующем примере с помощью ко-
манды 3DPOLY формируется двухвитковая спираль.



 
 
 

_3DPOLY
Specify start point of polyline: 0,0,0 – точка 1
Specify endpoint of line or [Undo]: @40<45,20 – точка

2
Specify endpoint of line or [Undo]: @40<135,20 –

точка 3
Specify endpoint of line or [Close/Undo]: @40<-135,20

– точка 4
Specify endpoint of line or [Close/Undo]: @40<-45,20

– точка 5
Specify endpoint of line or [Close/Undo]: @40<45,20

– точка 6
Specify endpoint of line or [Close/Undo]: @40<135,20

– точка 7
Specify endpoint of line or [Close/Undo]: @40<-135,20

– точка 8
Specify endpoint of line or [Close/Undo]: @40<-45,20

– точка 9
Specify endpoint of line or [Close/Undo]: Close –

замкните линию

При выполнении описанного примера следует учесть, что
не обязательно вводить с клавиатуры повторяющиеся строки
координат. Ранее введенные строки текста запоминаются в
буфере строк, благодаря чему их удобно вызывать в диало-
говую область с помощью клавиш ↑ и ↓ на функциональной
клавиатуре. Например, повторный ввод строки @40<45,20
можно осуществить, несколько раз нажав клавишу ↑ (пока



 
 
 

не появится нужная строка), и затем ввести ее клавишей
Enter. Но это не единственная возможность использования
данного приема: допускается также редактирование «подня-
той» строки с помощью клавиш ← и →, добавление симво-
лов с клавиатуры и удаление символов с помощью клавиши
Backspace.



 
 
 

 
Ввод сферических координат

 
Ввод сферических координат в трехмерном пространстве

также подобен вводу полярных координат на плоскости. По-
ложение точки определяется ее расстоянием от начала коор-
динат текущей ПСК, углом к оси X в плоскости XY и углом
к плоскости XY. Все координаты разделяются символом <.
Угол задается в градусах.

На рис. 4.8 показана точка с координатами 7<30<45. Эта
точка лежит на расстоянии 7 единиц от начала текущей ПСК,
под углом 30° к оси X в плоскости XY и под углом 45° к
плоскости XY.



 
 
 

Рис. 4.8. Указание сферических координат
 

Пример. Ввод сферических координат
 

Сферические координаты используются для получения
точек на сферической поверхности или, например, в случа-
ях построения трубопровода и т. п., когда наиболее важна
длина строящегося объекта, а не его ориентация. В ниже-
описанном примере командой 3DPOLY формируется пяти-
угольник с вершинами, лежащими на сфере, радиус которой
равен 50 единицам.

_3DPOLY



 
 
 

Specify start point of polyline: 50<20<-20 – точка 1
Specify endpoint of line or [Undo]: 50<30<5 – точка 2
Specify endpoint of line or [Undo]: 50<15<20 – точка 3
Specify endpoint of line or [Close/Undo]: 50<-15<20 –

точка 4
Specify endpoint of line or [Close/Undo]: 50<-30<5 –

точка 5
Specify endpoint of line or [Close/Undo]: Close –

замкните линию



 
 
 

 
Координатные фильтры

 
Координатные фильтры – это способ указания новых то-

чек в пространстве с использованием отдельных координат
уже имеющихся на чертеже объектов. Наибольшее распро-
странение координатные фильтры получили при вводе коор-
динат с помощью мыши. Их применение позволяет задавать
значение одной координаты, временно игнорируя значения
других. Для указания фильтра в командной строке исполь-
зуется формат:

<координата>

где <координата> – один из символов x, y, z или некоторое
их сочетание.

Существует набор из шести фильтров: .x, .y, .z, .xy, .xz
и .yz. Если, например, ввести .x, AutoCAD запросит указать
недостающие координаты по осям Y и Z.

Координатные фильтры можно вводить в командной стро-
ке в ответ на запрос ввода точки.



 
 
 

 
Определение пользовательской

системы координат
 

Как было сказано выше, в AutoCAD существуют: мировая
система координат World Coordinate System, WCS, и пользо-
вательская система координат User Coordinate System, UCS.
Ось X мировой системы координат направлена горизонталь-
но, ось Y – вертикально, а ось Z проходит перпендикуляр-
но плоскости XY. Начало координат – это точка пересечения
осей X и Y; по умолчанию она совмещается с левым нижним
углом рисунка. В любой текущий момент активна только од-
на система координат, которую принято называть текущей.
В ней координаты определяются любым доступным спосо-
бом.

Основное отличие мировой системы координат от поль-
зовательской заключается в том, что мировая система коор-
динат может быть только одна (для каждого пространства
модели и листа) и она неподвижна. Применение пользова-
тельской системы координат не имеет практически ника-
ких ограничений. Она может быть расположена в любой точ-
ке пространства под любым углом к мировой системе ко-
ординат. Разрешается определять, сохранять и восстанавли-
вать неограниченное количество ПСК. Проще выровнять си-
стему координат с существующим геометрическим объек-
том, чем определять точное размещение трехмерной точки.



 
 
 

ПСК обычно используется для работы с несмежными фраг-
ментами рисунка. Поворот ПСК упрощает указание точек
на трехмерных или повернутых видах. Узловые точки и ба-
зовые направления, определяемые режимами шаговой при-
вязки SNAP, сетки GRID и ортогонального режима ORTHO,
поворачиваются вместе с ПСК.

При работе в ПСК допускается поворачивать ее плоскость
XY и смещать начало координат. Все они при вводе отсчиты-
ваются относительно текущей пользовательской системы ко-
ординат. Соответствующая пиктограмма дает возможность
судить о положении и ориентации текущей ПСК, помогая ви-
зуализировать эту ориентацию относительно мировой систе-
мы координат, а также относительно объектов, содержащих-
ся в рисунке.

Пиктограмма ПСК всегда изображается в плоскости XY
текущей ПСК и указывает положительное направление осей
X и Y. Сама пиктограмма может располагаться как в начале
пользовательской системы координат, так и в другом месте.
Эту позицию регулирует команда управления пиктограммой
системы координат UCSICON. С помощью той же команды
можно выбрать одну из пиктограмм, размер, цвет, тип стре-
лок осей и толщины линий которых можно изменить (рис.
4.9).



 
 
 

Рис. 4.9. Варианты пиктограмм системы координат

Различные варианты пиктограмм ПСК используются для
облегчения восприятия изображения (рис. 4.10).

Рис. 4.10. Варианты пиктограмм системы координат

Появление символа «плюс» (+) в нижнем левом углу



 
 
 

пиктограммы указывает на ее расположение в начале ПСК.
Пользовательская система координат используется для пере-
мещения начала системы координат и/или изменения ори-
ентации осей системы координат в пространстве, что значи-
тельно упрощает процесс создания и редактирования объ-
ектов. При создании объекта удобно поместить начало си-
стемы координат в базовую точку объектов, особенно если в
данной точке формируется много объектов.

Пиктограмма с изображением сломанного карандаша го-
ворит о том, что плоскость XY практически параллельна на-
правлению взгляда. В этом случае при указании значений
координат с помощью мыши происходит выбор точек с ну-
левыми координатами z, что обычно не соответствует жела-
нию пользователя. Перед вводом точек или редактировани-
ем модели по виду пиктограммы следует оценить угол между
направлением взгляда и пиктограммой ПСК: если этот угол
мал, точный выбор точек с помощью мыши или другого ма-
нипулятора затруднителен.



 
 
 

 
Выбор пользовательской системы

координат в пространстве
 

Для изменения положения ПСК применяются следующие
способы:

• указание новой плоскости XY или новой оси Z;
• ввод нового начала координат;
• совмещение ПСК с имеющимся объектом;
• совмещение ПСК с гранью тела;
• совмещение ПСК с направлением взгляда;
• поворот ПСК вокруг одной из ее осей;
• расположение плоскости XY ПСК перпендикулярно вы-

бранному в качестве оси Z направлению;
• восстановление ранее сохраненной ПСК для совмеще-

ния с МСК;
• применение имеющейся ПСК к любому видовому экра-

ну;
• возврат к предыдущей ПСК.
Размещение, перемещение, вращение и отображение

пользовательских систем координат производится с помо-
щью команды UCS. Вызвать эту команду или варианты ее
исполнения можно из командной строки или с падающего
меню Tools → New UCS. Наиболее удобным представляется
вызов с плавающей панели инструментов UCS – рис. 4.11.



 
 
 

Рис. 4.11. Панель инструментов UCS

UCS – определение новой пользовательской системы ко-
ординат. Запрос команды UCS:

Current ucs name: *WORLD* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/

Previous/View/World/X/Y/Z/ZAxis] <World>: – задать
ключ

World – переход к мировой системе координат;

UCS Previous – восстановление предыдущей ПСК. При
этом сохраняется десять последних определенных ПСК;

Face UCS – определение пользовательской системы коор-



 
 
 

динат путем простого указания на грань;

Object – выравнивание системы координат по существую-
щему объекту;

View – выравнивание системы координат в направлении
текущего вида, то есть определение новой системы коорди-
нат с плоскостью XY, перпендикулярной направлению вида
(иначе говоря, параллельно экрану);

Origin – размещение ПСК в начале координат;

Z Axis Vector – определение нового положительного на-
правления оси;



 
 
 

3 Point – определение нового начала координат и направ-
ления осей X и Y по трем точкам;

X – поворот системы координат вокруг оси X;

Y – поворот системы координат вокруг оси Y;

Z – поворот системы координат вокруг оси Z;

Apply – применение текущей ПСК к выбранному видово-
му экрану.

Изменение текущей ПСК не влияет на изображение ри-
сунка на экране, если не включена системная переменная
UCSFOLLOW; в противном случае показывается вид в пла-
не текущей ПСК.

Если пиктограмма ПСК активизирована, она перерисовы-
вается в соответствии с ориентацией новой системы коорди-



 
 
 

нат.
С ПСК связаны следующие системные переменные.
• UCSXDIR, UCSYDIR определяют направление осей X

и Y в мировых координатах. Переменные доступны только
для чтения.

• UCSNAME определяет имя текущей ПСК.
• WORLDUCS равна 1, если текущая ПСК совпадает с ми-

ровой системой координат, и 0 – в противном случае.
• UCSORG определяет начало координат текущей систе-

мы координат для текущего пространства.

Управление системами координат осуществляется с по-
мощью команды DDUCS, вызываемой из падающего меню
Tools → Named UCS… или щелчком на пиктограмме Named
UCS… на панели инструментов UCSII. На вкладке Named
UCSs диалогового окна UCS можно присвоить любой поль-
зовательской системе координат уникальное имя.

В дальнейшем, открыв вкладку именованных ПСК Named
UCSs диалогового окна UCS, можно по ранее заданному
имени восстановить пользовательскую систему координат.
На рис. 4.12 показана вкладка Named UCSs этого окна с ра-
нее созданными пользовательскими системами координат.
Чтобы сделать систему координат текущей, необходимо на-
вести указатель мыши на ее имя и щелкнуть на кнопке Set



 
 
 

Current.

Рис. 4.12. Диалоговое окно управления именованными
ПСК

Чтобы добавить новую пользовательскую систему коор-
динат, необходимо присвоить текущей ПСК со стандартным
именем Unnamed уникальное название. Для этого достаточ-
но щелкнуть на имени текущей ПСК и набрать новое с кла-
виатуры в появившемся поле. Другие стандартные названия
– World и Previous – зарезервированы для мировой системы
координат и для той, которая использовалась перед текущей.
Именованные пользовательские системы координат приме-
няются в случаях, когда установленная ПСК, с которой неод-
нократно придется работать в дальнейшем, не совпадает со



 
 
 

стандартной. Если пользовательские системы координат бы-
ли определены как именованные, их легко восстановить в
диалоговом окне UCS на вкладке Named UCSs.

Для удаления пользовательской системы необходимо на-
вести на ее имя указатель мыши и нажать клавишу Delete.

При щелчке на кнопке Details раскрывается подробное
диалоговое окно UCS Details, в котором отражена вся ин-
формация о координатах точки начала и направлении осей
относительно текущей системы координат по каждой имено-
ванной ПСК (рис. 4.13).

Рис. 4.13. Диалоговое окно UCS Details



 
 
 

 
Работа с ПСК на видовых экранах

 
На видовые экраны выводятся различные виды модели.

Например, иногда требуется создать четыре видовых экрана
для показа модели сверху, справа, слева и снизу. Чтобы по-
высить удобство работы, для каждого видового экрана мож-
но задать и сохранить отдельную ПСК. В этом случае при пе-
реключении между видовыми экранами не происходит поте-
ри информации о ПСК каждого из них.

Сохранение ПСК для каждого видового экрана обеспечи-
вается системной переменной UCSVP. Если для видового
экрана она установлена в 0, то ПСК этого видового экрана
всегда совпадает с ПСК текущего активного видового экра-
на. Если для видового экрана системная переменная UCSVP
установлена в 1, то заданная для этого экрана ПСК запоми-
нается и не изменяется при переходе на другой.

Вкладка Settings диалогового окна UCS позволяет уста-
навливать различные режимы отображения пиктограммы
ПСК. Причем параметры отображения можно задавать либо
отдельно для текущего видового экрана, либо сразу для всех
активных видовых экранов текущего рисунка. Здесь же мож-
но указать, следует ли сохранять систему координат вместе с
видовым экраном, а кроме того, нужно ли на видовом экране
всегда показывать вид модели в плане.



 
 
 

 
Выбор стандартной

пользовательской системы координат
 

Ориентацию текущей ПСК в зависимости от мировой си-
стемы координат, предыдущей ПСК или ПСК, установлен-
ной для текущего вида, можно изменить в диалоговом окне
UCS, на вкладке Orthographic UCSs, показанной на рис. 4.14.
При этом достаточно выбрать объект и выполнить команду
DDUCSP, вызываемую из падающего меню Tools → Named
UCS….



 
 
 

Рис. 4.14. Диалоговое окно стандартных ПСК

С помощью данной команды можно определить новую
пользовательскую систему координат по отношению либо к
мировой, либо к текущей, выбрав соответствующий слайд в
диалоговом окне. Команду DDUCSP используют в основном
для переноса пользовательской системы координат из одной
ортогональной проекции в другую.

В AutoCAD имеется шесть стандартных ортогональных
ПСК: верхняя, нижняя, передняя, задняя, левая и правая.



 
 
 

По умолчанию параметры ортогональных ПСК рассчитыва-
ются относительно МСК.

Стандартной системой координат удобно пользоваться
при переходе от одной ортогональной проекции трехмерно-
го объекта к другой. Обычно эти проекции располагаются
в соседних окнах и признаком правильной установки ПСК
считается отображение в нужном окне правильной пикто-
граммы системы координат (ось X направлена вправо, ось Y
– вверх). Так как набор стандартных систем координат огра-
ничен, оптимальным является табличный способ их опреде-
ления.

 
Пример. Пользовательская

система координат
 

В нижеописанном примере необходимо перенести поль-
зовательскую систему координат в другую точку на рабочем
поле чертежа. После перемещения пользовательской систе-
мы координат из точки мировой системы координат в пик-
тограмме пропадает символ W. О том, что пиктограмма на-
ходится в точке пользовательской системы координат, сви-
детельствует значок «плюс» (+).

Запустите команду UCS, вызвав ее из падающего меню



 
 
 

Tools → New UCS → Origin или щелкнув на пиктограмме
Origin на панели инструментов UCS. Ответьте на запросы:

_UCS
Current ucs name: *WORLD* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/

Previous/View/World/X/Y/Z/ZAxis]
<World>: _o – переход в режим смещения начала

координат
Specify new origin point <0,0,0>: 195,140 –

координаты точки смещения начала координат

Выполните поворот пользовательской системы коорди-
нат:

_UCS
Current ucs name: *NO NAME* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/

Previous/View/World/X/Y/Z/ZAxis]
<World>: _z – переход в режим поворота вокруг оси

Z
Specify rotation angle about Z axis <90>: 30 – угол

поворота вокруг оси Z в градусах

Для возвращения в мировую систему координат запустите
команду UCS, вызвав ее из падающего меню Tools → New
UCS → World или щелкнув на пиктограмме World на панели



 
 
 

инструментов UCS. Команда выдаст запросы:
_UCS
Current ucs name: *NO NAME* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/

Previous/View/World/X/Y/Z/ZAxis]
<World>: _w – возвращение в мировую систему

координат



 
 
 

 
Глава 5

Свойства примитивов
 

Разделение рисунка по слоям
Управление видимостью слоя
Блокировка слоев
Цвет линии
Тип линии
Вес (толщина) линии
Фильтрация слоев
Использование свойств слоев
Копирование свойств объектов
Палитра свойств объектов

Слои подобны лежащим друг на друге прозрачным ли-
стам кальки. На различных слоях группируются различные
типы данных рисунка. Любой графический объект рисунка
обладает такими свойствами, как цвет, тип и вес (толщина)
линии, стиль печати. При создании объекта значения этих
свойств берутся из описания слоя, на котором он создает-
ся. При необходимости свойства любого объекта можно из-
менить. Использование цвета позволяет различать сходные
элементы рисунка. Применение линий различных типов по-
могает быстро распознавать такие элементы, как осевые или



 
 
 

скрытые линии. Вес (толщина) линии определяет толщину
начертания объекта и используется для повышения нагляд-
ности рисунка. Расположение объектов на различных слоях
позволяет упростить многие операции по управлению дан-
ными рисунка.

Инструменты, предназначенные для работы со свойства-
ми объектов, приведены на панелях инструментов Layers и
Properties (см. рис. 2.11 и 2.12).



 
 
 

 
Разделение рисунка по слоям

 
Построенные объекты всегда размещаются на определен-

ном слое. Например, один слой может содержать несущие
конструкции, стены, перегородки здания, другой слой – ком-
муникации, электрику и т. п., а третий – мебель, элементы
дизайна и т. д. Таким образом, комбинируя различные со-
четания слоев, можно компоновать необходимые комплекты
конструкторской документации.

Слои могут применяться по умолчанию, а также опреде-
ляться и именоваться самим пользователем. С каждым сло-
ем связаны заданные цвет, тип, вес (толщина) линии и стиль
печати. Размещая различные группы объектов на отдельных
слоях, можно структурировать рисунок. Послойная органи-
зация чертежа упрощает многие операции по управлению
его данными.

Например, можно создать отдельный слой для размеще-
ния осевых линий, назначить ему голубой цвет и штрих-
пунктирный тип линии CENTER. Впоследствии, если потре-
буется построить осевую линию, достаточно будет переклю-
читься на этот слой и начать рисование. Таким образом, пе-
ред каждым построением осевых линий не требуется вновь
устанавливать их цвет и тип. Кроме того, при необходимости
отображение слоя можно отключить. Возможность исполь-
зования слоев – одно из главнейших преимуществ рисова-



 
 
 

ния в среде AutoCAD перед черчением на бумаге.
Работая в пространстве листа или с плавающими видо-

выми экранами, можно установить видимость слоя индиви-
дуально для каждого видового экрана. При необходимости
показ какого-либо слоя на экране или его вывод на печать
можно легко отключить. Для всех слоев действуют одни и те
же установки лимитов рисунка, системы координат и коэф-
фициента экранного увеличения. Если какая-либо совокуп-
ность слоев используется часто, то эти слои, цвета и типы
линий рекомендуется сохранить в шаблоне. Слои представ-
ляют собой неграфические объекты, которые также хранят-
ся в файле рисунка.

Управление установками свойств слоев осуществляется в
Диспетчере свойств слоев Layer Properties Manager, показан-
ном на рис. 5.1. Оно загружается из падающего меню Format
→ Layer… или щелчком на пиктограмме Layer Properties
Manager на панели инструментов Layers.



 
 
 

Рис. 5.1. Диалоговое окно управления слоями

При создании нового рисунка автоматически создается
слой, названный 0, которому присваиваются белый цвет,
непрерывный тип линии Continuous, вес (толщина) линии
Default, по умолчанию соответствующий толщине 0.25 mm.
Этот слой не может быть удален и переименован.

Слои обладают следующими свойствами:
• Status – состояние слоя. Назначение слою статуса теку-

щего;
• Name – имя слоя. Состоит из алфавитно-цифровой ин-

формации, включающей специальные символы и пробелы;
• On – видимость слоя. При этом на экране изображаются

только те примитивы, которые принадлежат видимому слою,
однако примитивы в скрытых слоях являются частью рисун-
ка и участвуют в регенерации;

• Freeze – замораживание слоя. Означает отключение ви-
димости слоя при регенерации и исключение из генерации
примитивов, принадлежащих замороженному слою;



 
 
 

• Lock – блокировка слоя. Примитивы в блокированном
слое отображаются, но их нельзя редактировать. Блокиро-
ванный слой можно сделать текущим, рисовать в нем, замо-
раживать и применять к его примитивам команды справок
и объектную привязку;

• Color – цвет примитивов заданного слоя;
• Linetype – тип линии, которым будут отрисовываться все

примитивы, принадлежащие слою;
• Lineweight – вес (толщина) линии, которой будут отри-

совываться все примитивы, принадлежащие слою;
• Plot Style – стиль печати для заданного слоя;
• Plot – разрешение/запрет вывода слоя на печать;
• New VP Freeze – замораживание на видовом экране;
• Description – описание слоя.

Для создания нового слоя необходимо щелкнуть на пик-
тограмме New Layer (Alt+N), находящейся в верхней части
окна Диспетчера свойств слоев Layer Properties Manager, по-
казанного на рис. 5.1.

Создается слой, по умолчанию названный Layer1. Далее
все новые слои автоматически именуются Layer2, Layer3 и т.
д. – в порядке их создания. Чтобы присвоить слою уникаль-
ное имя, необходимо двойным щелчком на текущем назва-



 
 
 

нии активизировать поле ввода текста, а затем набрать имя
с клавиатуры и нажать клавишу Enter.

Если при создании нового слоя выделен один из имею-
щихся, то новый слой наследует его свойства. При необхо-
димости свойства нового слоя можно изменить.

Все вновь создаваемые в AutoCAD объекты размещаются
на текущем слое. При установке нового текущего слоя все
объекты будут создаваться на нем с использованием назна-
ченных ему цвета, типа и веса линии. Замороженные и зави-
симые от ссылок слои нельзя сделать текущими.

Для того чтобы сделать слой текущим, необходимо уста-
новить указатель мыши в графу Status соответствующего
слоя и щелкнуть на пиктограмме Set Current (Alt+C), на-
ходящейся в верхней части окна Диспетчера свойств слоев
Layer Properties Manager – см. рис. 5.1.

Сделать слой текущим можно двойным щелчком в графе
Status соответствующего слоя или с помощью системной пе-
ременной CLAYER.

Установить текущий слой также можно, выбрав его из рас-
крывающегося списка управления слоями на панели инстру-
ментов (рис. 5.2).



 
 
 

Рис. 5.2. Список управления слоями

Кроме того, удобно устанавливать слой объекта текущим.
Для этого следует выбрать этот объект, а затем щелкнуть на
пиктограмме Make Object’s Layer Current на панели инстру-
ментов Layers.

Для удобства список слоев, выводимый в Диспетчере
свойств слоев Layer Properties Manager, можно упорядочить
по любому свойству слоя. Допускается сортировка слоев по
их имени, видимости, цвету, типу, весу (толщине) линии или
стилю печати. Для сортировки списка достаточно щелкнуть
на заголовке столбца того параметра, по которому нужно от-
сортировать слои. Имена слоев могут быть отсортированы в
алфавитном порядке, как прямом, так и обратном.



 
 
 

 
Управление видимостью слоя

 
AutoCAD не отображает на экране объекты, расположен-

ные на невидимых слоях, и не выводит их на плоттер. Если
при работе с деталями рисунка на одном или нескольких сло-
ях чертеж слишком загроможден, допускается отключение
или замораживание неиспользуемых слоев. Кроме того, что-
бы запретить вывод на печать объектов определенных слоев,
например для вспомогательных линий, можно оставить эти
слои видимыми, но отключить их вывод на печать.

Выбор способа отключения показа слоев зависит от ха-
рактера их использования и сложности рисунка. Заморажи-
вать слои лучше в тех случаях, когда отображение слоя мож-
но отключить на длительное время. При этом ускоряется
выполнение команд зумирования ZOOM, панорамирования
PAN и VPORTS, упрощается выбор объектов и снижает-
ся время регенерации сложных рисунков. Объекты заморо-
женных слоев не обрабатываются функциями регенерации,
скрытия и тонирования. Разрешается замораживать и раз-
мораживать слои только на активном плавающем видовом
экране. При создании новых плавающих видовых экранов
можно автоматически замораживать на них определенные
слои. Например, допустимо скрытие размеров путем замо-
раживания слоя с размерными линиями для всех новых ви-
довых экранов. Если же на новом видовом экране требует-



 
 
 

ся отображение размеров, для этого видового экрана можно
разморозить соответствующий слой. Включение или отклю-
чение заморозки слоев для новых видовых экранов не изме-
няет видимость слоев на уже имеющихся видовых экранах.
В тех случаях, когда требуются частые настройки отображе-
ния слоев, лучше использовать их отключение, а не замора-
живание. При размораживании слоя выполняется регенера-
ция рисунка, после чего находящиеся на этом слое объекты
становятся видимыми.

На печать могут выводиться только объекты включенных
и размороженных слоев. Видимый слой печатается только в
том случае, если не отключен его вывод на печать.

Объекты отключенных слоев участвуют в регенерации,
хотя и не выводятся на экран или плоттер. Чтобы сделать
слой временно невидимым, его лучше отключить, а не замо-
розить, так как при размораживании слоя всегда выполняет-
ся регенерация рисунка. При включении слоя выполняется
перерисовка объектов данного слоя.

Для отключения слоя необходимо в Диспетчере свойств
слоев Layer Properties Manager, показанном на рис. 5.1, на-
вести указатель мыши на имя отключаемого слоя и затем
щелкнуть на пиктограмме On. Аналогично происходит и за-
мораживание слоя при щелчке на пиктограмме Freeze.

Кроме того, управлять видимостью слоев можно в рас-
крывающемся списке управления слоями на панели инстру-
ментов Layers (см. рис. 5.2).



 
 
 

Предусмотрена возможность запрещать печать любого
слоя, даже видимого. Если слой содержит, например, только
справочную информацию, то его вывод на печать можно от-
ключить. Запрещение печати слоя не изменяет его отобра-
жения на экране. Поэтому запрет печати удобно использо-
вать для слоев, содержащих вспомогательные элементы по-
строений. При этом перед выводом рисунка на печать та-
кие слои не требуется отключать. Запрет печати любого слоя
осуществляется в Диспетчере свойств слоев Layer Properties
Manager – см. рис. 5.1. С этой целью требуется выделить
слои, для которых необходимо разрешить или запретить вы-
вод на печать, и щелкнуть на пиктограмме Plot.



 
 
 

 
Блокировка слоев

 
Блокировку слоев полезно применять в случаях, ко-

гда требуется редактирование объектов, расположенных на
определенных слоях, с возможностью просмотра объектов
на других слоях. Редактировать объекты на заблокирован-
ных слоях нельзя. Однако они остаются видимыми, если
слой включен и разморожен. Можно сделать заблокирован-
ный слой текущим и создавать на нем объекты.

Допускается также применение на заблокированных сло-
ях справочных команд к объектам и привязка к ним с помо-
щью режимов объектной привязки. Заблокированные слои
можно включать и отключать, а также изменять связанные с
ними цвета и типы линий.

Блокировка слоя включается либо в Диспетчере свойств
слоев Layer Properties Manager, показанном на рис. 5.1, ли-
бо в раскрывающемся списке управления слоями на панели
инструментов Layers (см. рис. 5.2) щелчком на пиктограмме
Lock соответствующего слоя.



 
 
 

 
Цвет линии

 
Назначение объектам различных цветов облегчает работу

с рисунком, поскольку позволяет визуально идентифициро-
вать группы объектов.

Присвоение цветов слоям осуществляется в Диспетчере
свойств слоев Layer Properties Manager, показанном на рис.
5.1. Для этого необходимо щелкнуть на пиктограмме Color
соответствующего слоя. При этом загружается диалоговое
окно Select Color, предлагающее выбрать оттенок на палитре
– рис. 5.3.



 
 
 

Рис. 5.3. Диалоговое окно выбора цвета

Можно ввести либо его имя, либо номер в виде целого
числового значения от 1 до 255 в таблице индексов цветов
AutoCAD Color Index (ACI). Стандартные имена присвоены
только цветам с номерами от 1 до 7 (1 – красный, 2 – желтый,



 
 
 

3 – зеленый, 4 – голубой, 5 – синий, 6 – фиолетовый, 7 –
белый/черный).

Полноцветная палитра цветов True Color располагает на-
бором из 16 миллионов оттенков. При этом используются
две цветовые модели: RGB – где задаются красная, зеленая,
и синяя составляющие цвета, и HSL – где задаются оттенок,
насыщенность и яркость цвета.

Цвета можно присваивать как слоям, так и отдельным
объектам чертежа.

Кроме того, могут быть заданы ключевые слова ByLayer –
по слою и ByBlock – по блоку. ByLayer означает, что прими-
тив будет создаваться в соответствии с цветом, определен-
ным для текущего слоя. ByBlock означает, что объекты бу-
дут изображаться белым цветом до тех пор, пока их не объ-
единят в блок. Куда бы затем ни был вставлен блок, объекты
приобретут текущий цвет.

Интерес представляет работа с альбомами цветов – вклад-
ка Color Books диалогового окна Select Color (рис. 5.4), – ко-
торые содержат именованные образцы, что позволяет улуч-
шить вид рисунка и подготовить высококачественные пре-
зентационные материалы.



 
 
 

Рис. 5.4. Диалоговое окно альбомов цветов



 
 
 

 
Тип линии

 
Применение различных типов линий – еще один способ

визуального представления информации. Различные типы
линий отражают их разное назначение. Тип линии описыва-
ется повторяющейся последовательностью штрихов, точек и
пробелов. Линии сложных типов могут включать в себя раз-
личные символы. Пользователь имеет возможность созда-
вать собственные типы линий.

Конкретные последовательности штрихов и точек, отно-
сительные длины штрихов и пробелов, а также характери-
стики включаемых текстовых элементов и форм определя-
ются именем типа линии, а также его описанием.

Назначение типа линии слою осуществляется в Диспетче-
ре свойств слоев Layer Properties Manager. Для этого необхо-
димо щелкнуть на пиктограмме Linetype соответствующего
слоя. В открывшемся диалоговом окне Select Linetype, пока-
занном на рис. 5.5, выбирается подходящий тип линии. Если
в предлагаемом списке нет нужного варианта, следует под-
грузить его, щелкнув на кнопке Load… и указав в открыв-
шемся диалоговом окне Load or Reload Linetypes подходя-
щий образец линии (рис. 5.6), затем, вернувшись в диалого-
вое окно Select Linetype, установить указатель мыши на тре-
буемый тип линии.



 
 
 

Рис. 5.5. Диалоговое окно установки типа линии



 
 
 

Рис. 5.6. Диалоговое окно подгрузки различных типов ли-
ний

Ключевое слово ByLayer означает, что примитив будет со-
здаваться в соответствии с типом линии, определенным для
текущего слоя. Ключевое слово ByBlock означает, что при-
митивы будут изображаться сплошными (continuous) линия-
ми. Если эти объекты объединены в блок, им присваивается
тип линии, установленный для слоя, которому принадлежит
точка вставки блока.

Длина штрихов и пробелов, составляющих штрихпунк-



 
 
 

тирную линию, измеряется в условных единицах. Начальная
установка масштаба типа линии для каждого рисунка – од-
на единица. AutoCAD позволяет изменять масштаб изобра-
жения линии. Чем меньше масштаб, тем больше повторений
элементарного фрагмента линии.

Текущее значение глобального масштабного коэффици-
ента для всех объектов хранится в системной переменной
LTSCALE. Значением масштаба текущего объекта управля-
ет системная переменная CELTSCALE, которая изменяет
масштаб типа линий новых объектов. Настройка масштаба
типов линий на различных видовых экранах листа выполня-
ется с помощью системной переменной PSLTSCALE.

Для задания масштаба типов линий необходимо загрузить
Диспетчер типов линий Linetype Manager из падающего ме-
ню Format → Linetype… и щелкнуть на кнопке Show details
для включения подробного окна (рис. 5.7).



 
 
 

Рис. 5.7. Диспетчер типов линий

В области Details приведены следующие параметры теку-
щей линии:

• Name: – имя;
• Description: – пояснение;
• Use paper space units for scaling – масштаб в единицах

пространства листа;
• Global scale factor: – глобальный масштаб;
• Current object scale: – текущий масштаб;
• ISO pen width: – толщина пера по ISO.



 
 
 

Имеется возможность переименовывать типы линий в лю-
бой момент редактирования рисунка. Переименование ка-
кого-либо типа линии приводит к изменению его описания,
используемого в текущем рисунке. Название этого типа ли-
нии в библиотечном LIN-файле остается прежним. Нельзя
изменить имена типов линий ByLayer, ByBlock и Continuous,
а также типов линий, зависящих от внешних ссылок.

Типы линий можно сортировать по имени и описанию.
При этом типы линий ByLayer и ByBlock всегда находятся
в начале списка. Названия типов линий могут быть отсорти-
рованы в алфавитном порядке, как прямом, так и обратном.

Типы линий можно назначать любым объектам AutoCAD,
кроме текстовых объектов, точек, видовых экранов, беско-
нечных прямых, лучей, трехмерных полилиний и блоков.
Если длина объекта меньше длины элементарного фрагмен-
та типа линии, такой объект отрисовывается сплошной ли-
нией.

Для двумерной полилинии имеется возможность центри-
ровать образец типа линии в пределах каждого сегмента ли-
бо размещать образец непрерывно по всей ее длине. Управ-
ляет этими режимами системная переменная PLINEGEN.



 
 
 

 
Вес (толщина) линии

 
Веса линий определяют толщину начертания объектов и

используются при выводе объектов как на экран, так и на
печать. Наличие линий различной толщины необходимо при
оформлении чертежей: для создания линий основного кон-
тура, размеров, штриховки, невидимых линий и пр.

Для отображения на экране весов линий необходимо в
строке состояния нажать кнопку LWT.

Вес линии устанавливается в Диспетчере свойств слоев
Layer Properties Manager (см. рис. 5.1). Для этого необходи-
мо щелкнуть на пиктограмме Lineweight соответствующего
слоя, а затем в открывшемся диалоговом окне Lineweight вы-
брать из списка подходящее значение (рис. 5.8).



 
 
 

Рис. 5.8. Диалоговое окно установки веса линии

Веса линий можно выбирать из определенного ряда зна-



 
 
 

чений, среди которых есть специальный вес под названием
Default. По умолчанию вес линии Default соответствует тол-
щине 0,25 мм (0,01 дюйма), это значение устанавливается
системной переменной LWDEFAULT.

В пространстве модели нулевое значение веса линии со-
ответствует линии толщиной один пиксел, а при выводе на
печать – наименьшей величине, обеспечиваемой используе-
мым печатающим устройством. Все объекты, вес линии ко-
торых не превышает 0,025 мм (0,01 дюйма), отрисовываются
в пространстве модели линией толщиной один пиксел. Зна-
чения весов линии, вводимые в командной строке, округля-
ются до ближайшей стандартной величины.

Информация о весе линии сохраняется при экспорте ри-
сунка в другие форматы и при копировании объектов в бу-
фер обмена. Выбрать единицы представления веса линий
и задать значение для веса Default можно в диалоговом
окне Lineweight Settings, показанном на рис. 5.9. Для вы-
зова этого окна необходимо либо щелкнуть правой кноп-
кой мыши на кнопке LWT в строке состояния и выбрать
пункт Settings… из контекстного меню, либо нажать кнопку
Lineweight Settings… на вкладке User Preferences диалогово-
го окна Options, либо ввести команду LWEIGHT.



 
 
 

Рис. 5.9. Диалоговое окно установки параметров весов
линий

Единицы представления весов линий (миллиметры или
дюймы), используемые при создании новых объектов и сло-
ев, устанавливает системная переменная LWUNITS.

Способы отображения весов линий в пространствах мо-
дели и листа несколько различаются. В пространстве моде-
ли каждому значению веса линии соответствует конкретное
число пикселов, определяющих видимую на экране толщи-
ну линий. В пространстве листа видимая на экране толщи-
на начертания объекта устанавливается пропорциональной
текущему коэффициенту экранного увеличения. Использо-
вание в пространстве модели фиксированного числа пиксе-



 
 
 

лов для каждого веса линии облегчает идентификацию объ-
ектов по их толщине при любом коэффициенте экранного
увеличения. При этом необходимо помнить, что в простран-
стве модели видимая толщина линий может не соответство-
вать их действительной толщине. Значению веса линии 0 в
пространстве модели всегда соответствует линия толщиной
один пиксел. Толщина отображения остальных весов линий
(в пикселах) устанавливается пропорционально их точным
значениям.

В пространстве модели, когда включен режим отображе-
ния весов линий, в точках соединения концов отдельных
отрезков используется соединение со скосом без оконча-
ний линий. При этом угол скоса подбирается автоматически.
Окончания линий определяют способ изображения концов
отрезков и могут, например, представлять закругление или
скос. При выводе на печать с помощью стилей печатей мож-
но задавать различные типы соединений и окончания линий
для различных весов линий.

В пространстве модели в режиме отображения весов ли-
ний, толщина начертания любого объекта не зависит от ко-
эффициента экранного увеличения. Например, если весу
линии соответствует толщина четыре пиксела, то объекты с
таким весом всегда отрисовываются линией толщиной четы-
ре пиксела, даже при уменьшении экранного изображения
до максимально возможного значения.

Можно задавать масштаб отображения весов линий и из-



 
 
 

менять таким образом количество пикселов, соответствую-
щих весам линий в пространстве модели. Изменение мас-
штаба отображения не влияет на толщину линий при выво-
де на печать. Следует отметить, что если используемые ве-
са линий представлены более чем одним пикселом, то вре-
мя регенерации рисунка возрастает. Если устанавливаемый
по умолчанию масштаб отображения не изменялся, то веса
линий, меньшие или равные 0,025 мм (0,01 дюйма), отоб-
ражаются толщиной один пиксел и потому не снижают ско-
рость работы AutoCAD. При изменении масштаба отображе-
ния весов линий количество весов, соответствующих толщи-
не один пиксел, также изменяется. Для повышения скорости
работы AutoCAD в пространстве модели можно уменьшить
масштаб экранного отображения весов линий или вообще
отключить веса линий.

Веса линий игнорируются для шрифтов True Type, раст-
ровых изображений, точек и заливок для плоских фигур.



 
 
 

 
Фильтрация слоев

 
Иногда требуется, чтобы в списке имеющихся слоев Дис-

петчера свойств слоев Layer Properties Manager перечисля-
лись только определенные слои. Для указания выводимых в
список слоев используется функция фильтрации. Фильтра-
ция слоев может производиться по следующим критериям:

• по именам, цветам и типам линий, весам линий и стилям
печати, назначенным слоям;

• по состояниям слоев «включен/отключен»;
• по состояниям слоев «заморожен/разморожен»;
• по состояниям слоев «блокирован/разблокирован»;
• по состояниям слоев «печатать/не печатать»;
• по наличию/отсутствию слоев в текущем рисунке;
• по наличию/отсутствию зависимостей слоев от внешних

ссылок.
Инструменты, позволяющие настроить фильтры слоев,

находятся в левом верхнем углу Диспетчера свойств слоев
Layer Properties Manager (см. рис. 5.1).

New Property Filter (Alt+P) – загрузка диалогового ок-
на Layer Filter Properties, позволяющего настроить новый



 
 
 

фильтр слоев по свойствам (рис. 5.10).

Рис. 5.10. Диалоговое окно настройки свойств фильтра
слоев

New Group Filter (Alt+G) – создание нового группового
фильтра.

Layer States Manager (Alt+S) – загрузка Диспетчера кон-
фигураций слоев Layer States Manager (рис. 5.11).



 
 
 

Рис. 5.11. Диспетчер конфигураций слоев

• В области Layer properties to restore определяются сохра-
няемые состояния слоев:

• On/Off – включен/отключен;
• Frozen/Thawed – заморожен/разморожен;
• Visibility in Current VP – видимость на текущем видовом

экране;
• Locked/Unlocked – блокирован/разблокирован;
• Plot/No Plot – печатаемый/непечатаемый;
• Color – цвет;
• Linetype – тип линий;
• Lineweight – вес линий;



 
 
 

• Plot Style – стиль печати;
• New VP Frozen/Thawed – заморожен/разморожен на но-

вых видовых экранах;
• Turn off layers not found in layer state – отключить слои,

отсутствующие в конфигурации.
При щелчке правой кнопки мыши в левой области Дис-

петчера свойств слоев Layer Properties Manager появляется
контекстное меню (рис. 5.12), содержащее следующие пара-
метры:

Рис. 5.12. Контекстное меню настройки фильтров

• Visibility – видимость (включить, отключить, разморо-



 
 
 

зить, заморозить);
• Lock – блокировать/разблокировать;
• Viewport – видовой экран;
• Isolate Group – выделить группу (все видовые экраны,

только активный видовой экран);
• New Properties Filter… – загрузка диалогового ок-

на Layer Filter Properties, позволяющего настроить новый
фильтр слоев по свойствам (см. рис. 5.10);

• New Group Filter – новый групповой фильтр;
• Convert to Group Filter – преобразовать в групповой

фильтр;
• Rename – переименовать;
• Delete – удалить;
• Properties… – загрузка палитры свойств объектов

PROPERTIES.
При щелчке правой кнопки мыши в правой области Дис-

петчера свойств слоев Layer Properties Manager появляется
контекстное меню (рис. 5.13), содержащее следующие пара-
метры:



 
 
 

Рис. 5.13. Контекстное меню Диспетчера свойств слоев

• Show Filter Tree – показать дерево фильтров;
• Show Filter in Layer List – показать фильтры в списке;
• Set current – установить;



 
 
 

• New Layer – новый слой;
• Rename Layer – переименовать слой;
• Delete Layer – удалить слой;
• Change Description – изменить пояснение;
• Remove From Group Filter – удалить из группового филь-

тра;
• New Layer VP Frozen All Viewports – создать новый за-

мороженный слой на всех видовых экранах;
• VP Freeze Layer in All Viewports – заморозить слой на

всех видовых экранах;
• VP Thaw Layer in All Viewports – разморозить слой на

всех видовых экранах;
• Select All – выбрать все;
• Clear All – очистить все;
• Select All but Current – выбрать все, кроме текущего;
• Invert Selection – инвертировать выбор;
• Invert Layer Filter – инвертировать фильтр;
• Layer Filters – фильтр слоев (все, все используемые

слои);
• Save Layer States… – загрузка диалогового окна сохра-

нения новой конфигурации слоев New Layer State to Save;
• Restore Layer State… – загрузка Диспетчера конфигура-

ций слоев Layer States Manager для восстановления конфи-
гурации.



 
 
 

 
Использование свойств слоев

 
Имеется возможность присваивать свойства как слоям,

так и непосредственно объектам рисунка. При построении
нового объекта ему автоматически назначаются цвет, тип
и вес линии, а также стиль печати ByLayer. Если свой-
ство объекта имеет специальное значение ByLayer, фактиче-
ское значение этого свойства определяется параметром то-
го слоя, на котором находится объект. Например, при по-
строении на слое, которому назначены зеленый цвет, тип ли-
нии Continuous, вес линии 0.25 mm и стиль печати Default,
новый объект отображается с использованием именно этих
значений. Применение специального значения ByLayer, до-
ступного для таких свойств объекта, как цвет, тип линии,
вес линии и стиль печати, упрощает управление и манипу-
ляцию объектами рисунка. Кроме того, послойная организа-
ция чертежа упрощает визуальную идентификацию различ-
ных его элементов (деталей, крепежа, текстовой информа-
ции и т. д.) по свойствам слоев, на которых они располага-
ются.

Если необходимо, любому объекту можно присвоить
цвет, тип линии, вес линии или стиль печати, отличный от
соответствующего свойства слоя, на котором располагается
объект. Свойство объекта может иметь какое-либо опреде-
ленное значение (например, «красный» – для цвета) или од-



 
 
 

но из специальных значений ByLayer либо ByBlock. Новое
значение свойства объекта используется вместо соответству-
ющего свойства слоя до тех пор, пока этому свойству не бу-
дет возвращено значение ByLayer.

При выборе значения ByBlock свойства новых объектов
используют стандартные значения до тех пор, пока объек-
ты не будут объединены в блок. После создания блока из та-
ких объектов значения их свойств определяются свойствами
слоя, в который вставляется блок.

Рассмотрим пример: блок с именем СТУЛ образован из
двух объектов, сиденья и спинки. Исходные объекты, изоб-
ражающие сиденье и спинку стула, находятся соответствен-
но на слоях СИДЕНЬЕ и СПИНКА. Пусть блок СТУЛ встав-
ляется в слой с именем МЕБЕЛЬ, которому назначен фио-
летовый цвет. Если до создания блока объекты, соответству-
ющие спинке и сиденью, имели цвет ByLayer, то независи-
мо от слоя, в который вставлен блок, цвет сиденья и спин-
ки будет определяться текущим значением цвета слоев СИ-
ДЕНЬЕ и СПИНКА. Если до создания блока объекты, соот-
ветствующие спинке и сиденью, имели цвет ByBlock, то цвет
сиденья и спинки будет определяться текущим цветом того
слоя, в который вставлен блок (в данном случае это фиоле-
товый цвет).

Для быстрого просмотра и изменения цвета, типа линии
и ее веса можно использовать строку свойств объектов.

При выборе объекта, если ни одна из команд не актив-



 
 
 

на, динамически отображаются слой, цвет, тип и вес линии
данного объекта. Параметры выбранного объекта можно из-
менить, настроив их в раскрывающихся списках управления
цветом, типом или весом линии, но при этом не должна вы-
полняться ни одна команда. Чтобы сделать цвет, тип или вес
линии текущими, достаточно выбрать их соответственно из
раскрывающихся списков управления свойствами линии.



 
 
 

 
Копирование свойств объектов

 

Команда MATCHPROP предназначена для копирования
свойств заданного объекта другому объекту. Она вызывает-
ся из падающего меню Modify → Match Properties или щелч-
ком на пиктограмме Match Properties стандартной панели
инструментов.

Допускается копировать цвет, слой, тип линий, масштаб
типа линий, вес линий, стиль печати, трехмерную высоту и
другие свойства.

В процессе копирования свойств объектов можно изме-
нять параметры настройки свойств, например запретить ко-
пирование некоторых из них. Для этого необходимо щелк-
нуть на пиктограмме Match Properties стандартной панели
инструментов, выбрать объект, свойства которого необходи-
мо скопировать. Далее щелчком правой кнопки мыши вы-
звать контекстное меню, из которого выбрать пункт Settings.

Загрузится диалоговое окно настройки свойств Property
Settings (рис. 5.14), позволяющее настроить следующие па-
раметры.



 
 
 

Рис. 5.14. Диалоговое окно настройки свойств

• В области Basic Properties – определить основные свой-
ства:

– Color – цвет;
– Layer – слой;
– Linetype – тип линии;
– Linetype Scale – масштаб типа линий;
– Lineweight – вес линий;
– Thickness – высота;



 
 
 

– PlotStyle – стиль печати.
• В области Special Properties – определить специальные

свойства:
– Dimension – размер;
– Polyline – полилиния;
– Material – материал;
– Text – текст;
– Viewport – видовой экран;
– Shadow display – отображение тени;
– Hatch – штриховка;
– Table – таблица;
– Multileader – линия-выноска.



 
 
 

 
Палитра свойств объектов

 

Палитра свойств объектов PROPERTIES, показанная на
рис. 5.15, – это единый инструмент, управляющий практиче-
ски всеми свойствами объектов рисунка. На палитре собра-
но около 40 диалоговых окон и команд, которые были раз-
рознены в более ранних версиях AutoCAD. Загружается она
командой PROPERTIES, либо из падающего меню Modify
→ Properties, либо щелчком на пиктограмме Properties (Ctrl
+1) на стандартной панели инструментов.



 
 
 



 
 
 

Рис. 5.15. Палитра свойств объектов

Палитра свойств объектов Properties позволяет произво-
дить фильтрацию наборов выбранных объектов по их типу,
предоставляя возможность редактировать свойства каждого
объекта. В случае если текущий набор объектов не создан,
показывается текущее состояние таких свойств рисунка, как
стиль вывода на печать, ПСК, данные о видовых экранах, ги-
перссылки.

В верхней части палитры расположен раскрывающийся
список, содержащий типы и количество выбранных объек-
тов. Справа от него – кнопки переключения Toggle value of
PICKADD Sysvar и выбора объектов Select Objects и Quick
Select.

Ниже расположены следующие разделы.
• General – общие, содержит поля:
– Color – цвет;
– Layer – слой;
– Linetype – тип линий;
– Linetype scale – масштаб типа линий;
– Lineweight – вес линий;
– Thickness – высота.
• 3D Visualization – трехмерная визуализация, содержит

поля:
– Material – материал;
– Shadow display – отображение тени.



 
 
 

• Plot style – стиль печати, содержит поля:
– Plot style – стиль печати;
– Plot style table – таблица стилей печати;
– Plot table attached to – пространство таблицы стилей пе-

чати;
– Plot table type – тип стилей печати.
• View – вид, содержит поля:
– Center X – центр X;
– Center Y – центр Y;
– Center Z – центр Z;
– Height – высота;
– Width – ширина.
• Misc – разное, содержит поля:
– Annotation scale – масштаб;
– UCS icon On – знак ПСК включен;
– UCS icon at origin – знак ПСК в начале координат;
– UCS per viewport – ПСК в каждом видовом экране;
– UCS Name – имя ПСК;
– Visual Style – визуальный стиль изображения.
Палитра свойств объектов Properties может оставаться от-

крытой в процессе работы; она показывает свойства выбран-
ного объекта. Если выделено несколько объектов, в окне вы-
водятся только общие свойства, значения которых совпада-
ют у всех выбранных объектов. К общим свойствам относят-
ся цвет, слой, тип линии, масштаб типа линии, стиль печати,
вес линии, гиперссылка, высота.



 
 
 

 
Глава 6

Управление экраном
 

Зумирование
Панорамирование
Использование окна общего вида Aerial View
Перерисовка и регенерация
Изменение порядка рисования объектов

Система AutoCAD обладает широкими возможностями
отображения различных видов рисунка. Предусмотрены ко-
манды, которые позволяют при редактировании чертежа
быстро перемещаться от одного его фрагмента к другому для
визуального контроля внесенных изменений. Можно зуми-
ровать изображение, изменяя его экранное увеличение, или
производить панорамирование, перемещая рисунок по ви-
довому экрану; также допускается сохранение выбранного
вида с его последующим восстановлением для вывода на пе-
чать или просмотра. Кроме того, обеспечивается одновре-
менный просмотр различных участков рисунка путем раз-
деления области рисунка на несколько неперекрывающихся
видовых экранов.



 
 
 

 
Зумирование

 
Видом называется совокупность экранного увеличения,

положения и ориентации части рисунка, видимой на экране.
Основной способ изменения вида – выбор одного из имею-
щихся в AutoCAD режимов зумирования, при котором раз-
мер изображения фрагмента в области рисунка увеличива-
ется или уменьшается.

При зумировании либо увеличивают изображение с целью
большей детализации, либо уменьшают для того, чтобы на
экране помещалась большая часть рисунка (рис. 6.1, 6.2).

Рис. 6.1. Уменьшенное изображение рисунка



 
 
 

Рис. 6.2. Увеличенное изображение рисунка

При зумировании абсолютные размеры рисунка остают-
ся прежними – изменяется лишь размер его части, видимой
в графической области. В AutoCAD существуют различные
способы изменения вида, в том числе указание его границ
рамкой, изменение коэффициента увеличения/уменьшения
на заданную величину и показ рисунка в его границах.

Операция зумирования осуществляется командой
ZOOM, вызываемой из падающего меню View → Zoom, как
показано на рис. 6.3, либо же со стандартной или плавающей
панели инструментов Zoom (рис. 6.4).



 
 
 

Рис. 6.3. Команда зумирования в падающем меню



 
 
 

Рис. 6.4. Команда зумирования на стандартной и плава-
ющей панелях инструментов

Запрос команды ZOOM:
Specify corner of window, enter a scale

factor (nX or nXP), or [All/Center/Dynamic/Extents/
Previous/Scale/Window/Object] <real time>: – указать
угол рамки, ввести масштаб, или один из
ключей (Все/Центр/Динамика/Границы/Предыдущий/
Масштаб/Рамка/Объект)

Команда ZOOM на стандартной панели инструментов
имеет несколько исполнений. Ниже приводится подробное
описание каждого из них.



 
 
 

Zoom Realtime – увеличение и уменьшение масштаба
изображения в режиме реального времени .

Команда ZOOM с ключом real time обеспечивает возмож-
ность интерактивного зумирования изображения в режиме
реального времени. При перемещении указателя мыши по
видовому экрану происходит динамическое увеличение или
уменьшение выводимого на экране рисунка.

Для активизации функции зумирования в реальном вре-
мени можно либо выбрать команду из падающего меню View
→ Zoom → Realtime (см. рис. 6.3), либо щелкнуть на пикто-
грамме Zoom Realtime на стандартной панели инструментов
(см. рис. 6.4), либо ввести слово ZOOM в командной строке
с ключом real time. Этот ключ используется по умолчанию
при вызове команды ZOOM. При нажатии клавиши Enter по-
сле ввода команды в командной строке устанавливается ре-
жим зумирования в реальном времени.

В этом режиме пользователь может изменять экранное
увеличение выводимого изображения, перемещая вверх или
вниз по видовому экрану указатель мыши. Поместив его в
середину изображения на экране и удерживая нажатой кноп-
ку мыши, можно увеличить или уменьшить изображение на
100 %, передвинув указатель соответственно в верхнюю или
нижнюю часть видового экрана.



 
 
 

Если отпустить кнопку мыши, зумирование приостанав-
ливается. Пользователь может отпустить кнопку, переме-
стить указатель в другую позицию на рисунке, а затем снова
нажать, чтобы продолжить зумирование в новой позиции.

Для выхода из режима зумирования можно использовать
контекстное меню, выбрав в нем пункт Enter, или нажать на
клавиатуре клавишу Esc.

Если применяется функция предварительного просмотра
печатаемого чертежа, то пределы зумирования ограничены
разрешающей способностью используемого плоттера. При
увеличении изображения в окне предварительного просмот-
ра операция зумирования прекращается в тот момент, когда
точка на экране в точности соответствует точке (или шагу)
используемого плоттера. Увеличение изображения при зу-
мировании в окне предварительного просмотра допускается
только до тех пределов детализации изображения, которые
может обеспечить плоттер или принтер.

При достижении предела увеличения изображения на те-
кущем виде символ «плюс» (+) на указателе зумирования
исчезает, что свидетельствует о невозможности дальнейше-
го зумирования в данном направлении. Аналогичным обра-
зом при уменьшении рисунка до предела (до границ теку-
щего вида) на указателе зумирования исчезает символ «ми-
нус» (–). Еще больше уменьшить рисунок после вывода гра-
ниц текущего вида нельзя.



 
 
 

Zoom Window – определение области отображения с по-
мощью рамки. Для активизации функции зумирования рам-
кой необходимо выбрать команду из падающего меню View
→ Zoom → Window либо щелкнуть на пиктограмме Zoom
Window на стандартной панели инструментов. После следу-
ет задать два противоположных угла прямоугольной рамки.
При этом левый нижний угол обозначенной рамки становит-
ся левым нижним углом нового вида. Форма нового вида
может несколько отличаться от формы рамки, так как при
зумировании вид вписывается в область рисунка. Команда
ZOOM с ключом Window выдает следующие запросы:

Specify corner of window, enter a scale factor (nX
or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: _w

Specify first corner: – указать первый угол окна
Specify opposite corner: – указать противоположный

угол окна

Zoom Dynamic – динамическое определение области отоб-
ражения. Вызывается из падающего меню View → Zoom →
Dynamic либо щелчком на пиктограмме Zoom Dynamic на
стандартной панели инструментов. Используется для изме-



 
 
 

нения вида без регенерации рисунка. Команда ZOOM с клю-
чом Dynamic отображает видимую часть рисунка в рамке,
представляющего текущий вид. Путем перемещения этой
рамки и изменения ее размеров выполняются зумирование
и панорамирование рисунка. Видовое окно перемещается
по рисунку при нажатой левой кнопке мыши; аналогичным
способом изменяются и размеры окна. Видовое окно можно
передвигать по изображению, когда окно содержит символ
Х, и изменять его размеры в состоянии, когда имеется сим-
вол стрелки →. Переключение из одного состояния в другое
осуществляется щелчком левой кнопки мыши. При нажатии
клавиши Enter изображение, заключенное в видовом окне,
выводится на видовой экран. В зависимости от используемо-
го видеомонитора границы текущего вида обозначаются зе-
леной пунктирной линией, а границы рисунка – синей. Гра-
ницы рисунка в данном случае либо соответствуют лимитам
рисунка, либо ограничивают область, реально занимаемую
изображением (если она выходит за пределы лимитов).

Zoom Scale – установка масштабного коэффициента уве-
личения. Вызывается из падающего меню View → Zoom →
Scale либо щелчком на пиктограмме Zoom Scale на стандарт-
ной панели инструментов. Масштабирование вида использу-
ется в том случае, если изображение требуется уменьшить



 
 
 

или увеличить на точно заданную величину. При этом необ-
ходимо указать коэффициент экранного увеличения одним
из трех способов:

• относительно лимитов рисунка;
• относительно текущего вида;
• относительно единиц пространства листа.
Команда ZOOM с ключом Scale выдает следующие запро-

сы:
Specify corner of window, enter a scale factor (nX

or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: _s

Enter a scale factor (nX or nXP): – указать
масштабный коэффициент

Чтобы экранное увеличение было задано относительно
лимитов рисунка, достаточно лишь ввести значение коэф-
фициента. Например, если это 1, то в графической области
будет располагаться рисунок в своих лимитах. Центр рисун-
ка совпадает с центром предыдущего вида. Для увеличения
или уменьшения изображения следует указать соответствен-
но большее или меньшее значение коэффициента. Если вве-
сти 2, изображение будет вдвое больше, чем при коэффици-
енте 1, а если ввести 0.5 – вдвое меньше.

Для масштабирования вида относительно текущего нуж-
но после значения коэффициента добавить латинскую бук-
ву x. Так, для увеличения изображения текущего вида вдвое
понадобится ввести 2x, а для уменьшения вдвое – 0.5x. Ввод



 
 
 

1x не изменяет изображение.

Zoom Center – определение области изображения путем
ввода точки центра и высоты окна в единицах рисунка. Вы-
зывается из падающего меню View → Zoom → Center либо
щелчком на пиктограмме Zoom Center на стандартной пане-
ли инструментов. Команда ZOOM с ключом Center выдает
следующие запросы:

Specify corner of window, enter a scale factor (nX
or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: _c

Specify center point: – указать центральную точку
Enter magnifi cation or height: – указать увеличение

или высоту

Для указания высоты можно использовать абсолютное
значение – число. При этом изменение происходит относи-
тельно полного вида. Если требуется задать изменение мас-
штаба относительно текущего вида, за числом следует вве-
сти латинскую букву x. При работе с плавающими видовы-
ми окнами для увеличения вида относительно пространства
листа необходимо ввести после числа латинские буквы xp.



 
 
 

Zoom Object – отображение области, которая содер-
жит выбранные объекты. Вызывается из падающего меню
View → Zoom → Object либо щелчком на пиктограмме
Zoom Object на стандартной панели инструментов. Команда
ZOOM с ключом Object производит вычисление коэффици-
ента экранного увеличения с учетом границ, в которые впи-
сан выбранный объект, и выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX
or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: _o

Select objects: – выбрать объекты

Zoom In – увеличение изображения. Вызывается из падаю-
щего меню View → Zoom → In либо щелчком на пиктограм-
ме Zoom In на стандартной панели инструментов. Команда
ZOOM с ключом 2x выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX
or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: 2x

Zoom Out – уменьшение изображения. Вызывается из па-



 
 
 

дающего меню View → Zoom → Out либо щелчком на пикто-
грамме Zoom Out на стандартной панели инструментов. Ко-
манда ZOOM с ключом .5x выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX
or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>: .5x

Zoom All – отображение всей области чертежа или обла-
сти внутри границ, если они заданы. Вызывается из падаю-
щего меню View → Zoom → All либо щелчком на пиктограм-
ме Zoom All на стандартной панели инструментов. Коман-
да ZOOM с ключом All позволяет увидеть на экране рису-
нок целиком. Если некоторые его объекты расположены вне
лимитов, он изображается в своих собственных границах.
При этом происходит регенерация рисунка. Если все объек-
ты находятся в пределах лимитов, команда выводит чертеж
в его лимитах. С помощью данного метода удобно контро-
лировать размещение объектов относительно области рисо-
вания.

Zoom Extents – отображение области, которая содержит



 
 
 

все примитивы чертежа. Вызывается из падающего меню
View → Zoom → Extents либо щелчком на пиктограмме
Zoom Extents на стандартной панели инструментов. Коман-
да ZOOM с ключом Extents производит вычисление коэф-
фициента экранного увеличения с учетом границ текущего
видового экрана, а не текущего вида. Чаще всего видовой
экран отображается полностью; в таком случае результат ра-
боты функции очевиден и понятен. Однако, когда команда
ZOOM используется в пространстве модели при работе в ви-
довом экране пространства листа для зумирования за преде-
лами границ этого видового экрана, некоторая часть зуми-
руемой области может остаться за пределами видимости.

Zoom Previous – использование предыдущего вида рисун-
ка. Вызывается из падающего меню View → Zoom → Previous
либо щелчком на пиктограмме Zoom Previous на стандарт-
ной панели инструментов. При работе с мелкими деталя-
ми часто возникает необходимость уменьшить изображе-
ние, чтобы просмотреть сделанные изменения в общем виде.
Для быстрого возврата к предыдущему виду служит коман-
да ZOOM с ключом Previous. Она восстанавливает только
экранное увеличение и положение вида, но не содержимое
редактируемого рисунка.

Программа AutoCAD способна восстанавливать последо-



 
 
 

вательно до 10 предыдущих видов. В это число входят виды,
полученные не только при зумировании, но и при панора-
мировании, восстановлении и установке вида в перспективе
или в плане.



 
 
 

 
Панорамирование

 

Pan Realtime – панорамирование в реальном времени.
Команда PAN обеспечивает возможность интерактивного

панорамирования изображения. При перемещении указате-
ля мыши по видовому экрану происходит динамическое пе-
ремещение изображения. Для активизации функции пано-
рамирования в реальном времени можно либо щелкнуть на
кнопке Pan Realtime на стандартной панели инструментов,
либо выбрать команду из падающего меню View → Pan →
Realtime.

Режим панорамирования в реальном времени использует-
ся по умолчанию при вызове команды PAN.

Чтобы изменить положение изображения на видовом
экране в режиме панорамирования в реальном времени, сле-
дует перемещать указатель мыши, удерживая ее левую кноп-
ку нажатой. Панорамирование может выполняться в одном
направлении до тех пор, пока не потребуется полная реге-
нерация изображения или не будут достигнуты лимиты ри-
сунка. В этом случае к изображению указателя панорами-
рования добавляется соответствующий направлению сим-
вол-ограничитель.

Для выхода из режима панорамирования или переклю-



 
 
 

чения между режимами панорамирования и зумирования
можно использовать контекстное меню; при этом необходи-
мо нажать клавишу Enter или Esc.



 
 
 

 
Использование окна

общего вида Aerial View
 

Команда DSVIEWER осуществляет вызов диалогового
окна Aerial View, обеспечивающего интерактивное управ-
ление экранным увеличением текущего видового экрана.
Также окно Aerial View, показанное на рис. 6.5, вызывается
из падающего меню View → Aerial View. В нем отображается
общий вид рисунка и предоставляется возможность быстро-
го перемещения в любую его часть. Если окно Aerial View
открыто в ходе работы, можно производить панорамирова-
ние и зумирование, не используя меню или ввод команд.



 
 
 

Рис. 6.5. Окно общего вида

При каждой регенерации рисунка в AutoCAD происхо-
дит обновление содержимого виртуального экрана, то есть
он очищается и заполняется заново. Окно Aerial View обес-
печивает возможность просмотра содержимого виртуально-
го экрана AutoCAD.

Это окно работает со всеми видами пространства модели.



 
 
 

Его легко отбуксировать в любое место экрана. Изменение
размеров окна производится при помощи буксировки гра-
ниц.

Открыв окно Aerial View, можно оставить его видимым
в ходе работы, а затем, когда необходимость в нем отпадет,
закрыть. Оно позволяет зумировать и панорамировать изоб-
ражение в окне рисунка AutoCAD в реальном времени.

Зумирование вида может производиться путем создания
в окне Aerial View новой рамки вида. Для увеличения ви-
димых размеров рисунка рамка должна быть меньше, для
уменьшения – больше. При создании или изменении раз-
мера рамки соответствующие изменения вида параллельно
отображаются в области рисунка.

Панорамирование рисунка выполняется путем перемеще-
ния рамки вида без изменения ее размеров. При этом изме-
няется только вид – экранное увеличение остается прежним.



 
 
 

 
Перерисовка и регенерация

 
Чтобы обновить изображение на экране монитора, его

можно перерисовывать или регенерировать. При регенера-
ции, кроме перерисовки изображения текущего видового
экрана, производится пересчет экранных координат (преоб-
разование значений с плавающей точкой из базы данных
в соответствующие целочисленные экранные координаты)
всех объектов базы данных рисунка. Таким образом, пере-
рисовка происходит быстрее, чем регенерация.



 
 
 

 
Конец ознакомительного

фрагмента.
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